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1.2. Nuclei Studio IDE F#;;

N HER P PuE B R, A SORYHERR A R PiSe # E#E 47 1Y) Nuclei Studio IDE 044 & 4662
ORA T BB Z AR50 P AR R AT ML, Bk A
https://www. nucleisys. com/download. php, UIE 1-1 7N,

FA P A] DAAE RS SR B A T b ) “ REgbhty” , WIEH PR, FE6 N Windows B
Linux [ NucleiStudio E4if (GERE: CORBHA B MG N #Eb 0, HABRSARER, HP
5 B AT 2B FH o R AN Bk 4 FH M AT A

H i C. 7€ Win 10 64 7 £%, Ubuntu 18.04/20.04 fil Redhat7.6 64 A7 A _FIGAEMR, HE
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RISC-V GNU Toolchain Nuclei OpenOCD

3 Windows v 3 Centos/Ubuntu x86-64 A~ 3 Windows x86-32 oV 3 Linux x86-64 v

Windows Build Tools Nuclei Studio IDE

3 Windows 3 Windows x86-64 v 3 Linux x86-64 ¥

¥ Nuclei Studio User Guide ¥

& 1-1NucleiStudio IDE kALK T4k S

1.3. Nuclei Studio IDE %3

2 5¢ i NucleiStudio IDE 48 446 N2, 5 G5 T3 anE 1-2 (FREEH AT
BEHRD , SRINEIT

B  NucleiStudio # 4

® ZHMETHE I Nuclei Studio IDE HJ# . & BHAKMA LA T RES A
T S8

7/

B HBird Driver.exe (2021.02 fRAS#A B4
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® N Windows JR#RHE, I ytRig 54 1 USB SR80 2 3.

® 7t Windows 85T, RZHRSSN, T2 IKG) 1% USB W& REWH R4t

P
® T 2021.02 iAH HEH ) openoed 51 N T AIKTHE
B SerialDebugging Tool (2021.02 RAEA ML)

® X Windows [R$ft, b 0y eh DHEB 78k e mT AT Ja SR
A i R R T EE R .

Data (D:) » NucleiStudio IDE 202102-win64 »

s

B &Pt HEA it Fh
NucleiStudio 2021/2/2 10:44 e

1-2NucleiStudio IDE &4 301N 2

2. J83h Nuclei Studio
J5 5 Nuclei Studio IZE SR (windows A1 linux 42 fE 40 F#/E) -

B H X NucleiStudio IDE X474 NucleiStudio SC4H 32 K i B mT $047 3044, BITT 3 5
Nuclei Studio, @ 2-1 i~

B 55— k)55 Nuclei Studio J&, &5 X iEHEE R 15 B Workspace HF#42, 1% H ¥
TS S8 M H TR, e 2-2 Fik.

B KB4 Workspace HX2 J5, #ii “Launch” %4, ¥ % )53) Nuclei Studio. 55—
& 215 1 Nuclei Studio AWK 2-3 Frx.

B 2021.02 R & Nuclei Studio ERiA<[F T Launch Bar, {#2& 9.1 7F/3 Nuclei
Studio F ¥ Launch Bar Thfg, 7578w FRAM TR,
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Data (D:) » NucleiStudio IDE 202102-win64 » NucleiStudio
EFR ZHEs Eitl F
configuration 2021/2/2 10:44 prg iz
features 2021/2/2 10:44 prgla=>c3
jre 2021/2/2 10:44 S
p2 2021/2/2 10:44 S
plugins 2021/2/2 10:44 BVE S
readme 2021/2/2 10:44 itk
toolchain 2021/2/2 10:44 prglisyes
tools 2021/2/2 10:44 prglisaes
] artifactsxml 2021/2/2 10:35 XML 324t 213 KB
ecli-psec.exe Click Here 2021/2/21032 R FRRER 127 KB
Q notice.html 2021/2/2 10:32 QQBrowser HTML ... 10 KB
= Nuclei Studio User Gui e.pdf 2021/2/2 10:37 Adobe Acrobat Do... 8,129 KB
I@ NucleiStudio.exe I 2021/2/2 10:32 MNFHER 408 KB
&+ | NucleiStudio.ini 2021/2/2 10:32 [i=1ia— 1 KB
=] Ver.2021-02.txt 2021/2/210:37 AR 0 KB
2-1 Wi “NucleiStudio.exe” &z Nuclei Studio
@ NucleiStudio IDE Launcher X

Select a directory as workspace

NucleiStudio IDE uses the workspace directory to store its preferences and development artifacts.

Workspace: | [C:\Users\24954\NucleiStudio workspace}

Browse...

[ Use this as the default and do not ask again

2-2 ¥ E Nuclei Studio ) Workspace H3x
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@ CPDE - NucleiStudio
File Edit Source Refactor Navigate Search Project Run RV-Tools Window Help

= @&Welcome

SHNudeiStudio  Welcome to the NucleiStudio for C/C++ Developers

Open a file from the filesystem [ Aiways show Welcome at start up [\s

K 2-3 % —&J23) Nuclei Studio Ft1fi

3. Nuclei Studio E# i 5o

Nuclei Studio H 2021.09 i%)5, ¥ IDE 5 SDK 5847r &, ¥ % M4 #) Nuclei
Package(NPK) (100 B 1) 77 sU#HAT BEAR TAE S B, 77 P 47 A R SDK 15 A I
HAE IDE FOIgoRe] TREIHEH, %% Nuclei SDK #1 HBird SDK A& 411/ 5] () SoC IP 7~
mPEME SDK, AT LT R K Zip G175 X LB Nuclei Package Management J5 T S A
i

4. Nuclei Studio NPK Th&t

Nuclei Studio H'4 % 7 %F Nuclei Package (NPK) IhAEf5e#E0H, 7T R & 8E A
F AT &AL, 3 Hi#id Nuclei Package Management 77 253 A\ %] Nuclei Studio H/# [,
WRE CPUIP &/, AILLE H E S i SDK BEAE B0 PL 3 FE NPK,  FF5 A\ £ Nuclei Studio
A, WiRsE SoCIP % 7, W LR ML SDK Tk Zip B, SN, WEEHFRA,

ARSCAE PR A BRI SR B T, REERBHECER S T, AHERE. SR s i A S 2 il oy WA TE 15



R
NUCLEI

AT UK AR 2 1) NPK, g%t i ff) BSP ek APP B EAEE =7, &F NPK
INREIVEAIN 28, LR JGSEH B B2 L https://github.com/Nuclei-Software/nuclei-
sdk/wiki/Nuclei-Studio-NPK-Introduction. @iL7E 54 1 SDK # 5] A\ npk BhfE, &5
npk.yml 7] LLi% #] Project Wizard Zhfg 13573 52 4L «

Tk ZAE M Nuclei Studio #H47 TAEIGIHE, 56Xt 1) SDK NPK Zip %% £ IDE
T ATARE AN R BT AR DRI BT AN R ROREAR A%, AR AN [R] BB N 5 22 (1) SDK I
f, AR I A AN [ P G 12 B R AR TR 6

AEWAE RVSTAR JT AW E, DLEiEAED GD32VF103 1 T2 AFIHLE /4 Nuclei Studio
Iifie, RVSTAR JT & MOT % 75248 B nuclei_sdk /) npk £, FE4IRGRISE S %2 GET.

B 7 Nuclei Studio K H, 52K npk =ik, F77EELE Nuclei Studio kAl
AT &E 2PrA B npk JF AT %3, ESREFEEE “RV-Tools-->Nuclei Package
Management” 7E5% H ] Nuclei Package Management & i 71117 npk & ¥ 41 4-3.
7f Nuclei Package Management U1, 4G /&iidi—F Refresh 3KHEGHT ) npk 55, npk
ZIERIRAS A Not Installed 4R 5k b B CUAEZE 2235 1) npk, &t Download #4742 %:, A&
HFE %2 sdk-nuclei_sdk FBCHTHCA 0.3.7, %358 npk IREE N

[2) Problems 1 Tasks Bl Console £ [ Properties 4 oB EEER B2 8
CDT Build Console ftest1]
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4-1 #k X\ SDK Manage

Q|

O

MB-8-=08

@ NucleiStudio_workspace - NucleiStudio IDE
File Edit Source Refactor Navigate Search Project Run RV-Tools Window Help
| || No Launch Configurations v on: |- v i BrA-Bie| S BO G- 0
By -RHET - OO
75 Project Explorer 32 BE%Y § -0 = O E=Outline 32 @ Build Targets =0
There are no projects in your workspace.
To add a project: There is no active editor that provides an
) . outline.
€ New Nuclei RISC-V C/C++ Project
Create a new Makefile project in a directory
containing existing code
Create a new C or C++ project
9 Create a project..
a1 Import projects... Nuclei Package Management O
Nuclei Packages
Name Size Status Qwner Description
~ [] =d Software Development Kit
v 0@ nudlei
v (1@ sdk-nuclei sdk
0% 035 2281 M8 |7 nuclei Nuclei Software Development Kit Nuclei..
0% 037 3956 MB , Not Installed nuclei Nuclei Software Development Kit Nuclei...
> []8 sdk-hbird_sdk
~ [](2 XinShengTech
v OB sdk-cm32mar
O% 110 47.08MB 7, Notinstalled  XinShengTech HERHEMCU CM32MAcREUETEE. .
v [] o0 Template Package
> (0@ nudei
< >
Refresh| Available Nuclei Package List Download | Import| |Remove
View log
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- o x

File Edit Source Refactor Navigats Search Projsct Run RV-Tools Window Help
(o] || No Launch Canfigurations ~on: | vl LB | S B G- B0 8 G
[ Ne=0 e nifg-fl-v=ae-o0- | Q @
[f5 Project Explarer & BESY § -0 = B B Outline 52 @ Build Targets =g
There are no prajects in your warkspace. L
To add a project: There is no active editor that provides an
@ New Nuclei RISC-V C/C+ + Project

outline.
Create a new Makefile project in a directory

containing existing code

Create a new C or C++ project
[ Create a project..

i Import projecs... Nuclei Pa e Management

Nuclei Packages

Name Size Status Owner Description
v [W] =+ Software Development Kit
~ @@ nudlei
~ @ B sdk-nuclei_sdk
1%, 035 2281 MB Not Installed nuclei

Nuclei Software Development Kit Nuclei.

~
o
3956 MB ) Not Installed nuclei Nuclei Software Development Kit Nuclei...

~ []@ XinShengTech
v [J 8 sdk-cm32méuocr

O% 110 4708 MB ) Notinstaled  XinhengTech SERHEMCU CM32MacRIMTESE, - B~ =08
~ [ tep Template Package
> 0@ nudei

Refresh

Available Nuclei Package List Import | | Remove:

View log

4-3 G E
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@ nucisudio o

o 1D - [m] X
file Edit Source Refactor Navigats Search Project Run RV-Tools Window Help
&][e][=]]- | No Launch Corfigurations | on:|— valo - B8-S @O @ -B-E-F -0 Q-
A= 5 D)~ Bl ot o~ | 02 Q @
£ Project Explorer &1 BE®Y § =0 = B2 Outline 52 (@ Build Targets = A
There are no prajects in your warkspace. @ i
To add a praject: There is no active editor that provides an
outline.
@ New Nuclei RISC-V C/C+ + Project
Create a new Makefile project in a directory
containing existing code

Create a new C or C++ project

[ Create a project..

21 Import projects... = Nuclei Package Management |

Nuclei Packages
Name Size Status Owner Description
v [ = Software Development Kit
~ (@ nudei
~ [J 8 sdk-nuclei_sdk
0% 037 1284MB | @ Installed nuclei Nuclei Embedded Software Developme...
0% 035 2281MB 7, Mot Installed nudlei Nuclei Software Development Kit Nudlei...

0@ nuclei

<

OB sdk-hbird_sdk
~ [](@ XinShengTech
OB sdk-cm32mdxxr
~ [ tep Template Package

>

# B~~~ = 0

Refresh

Available Nuclei Package List

Download | | Import| | Remeve

View log

4-1 A

s

B

H

B OHE AR, WTRESRRAS T, %P “File --> New --> New Nuclei RISC-V C/C++
Project” , 4 K 4-1. #1] PA{E Project Explorer #1LE# i+ “New Nuclei RISC-V

C/C++ Project”

AR N E RSO G RBHOM KA, REURBHRE I, AR sl e A2 A i sl A
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, - o x
File Edit Source Refactor Navigate Search Project Run RV-Tools Window Help
New AIEESHIANS | @ New Nuclei RISC-V C/C++ Project - SRS BB E B0 R R BE S
Open Fil [ Makefile Project with Existing Code a ol
e =
Recent Fil > 9 Project. = O 5= Outine 2 @BuildTargets & § = O
Close Editor ctrisw Convert to a C/C++ Project (Adds C/C+ + Nature) Tmebrerratis tinpet sameie
Close All Editors Curl+ShiftsW | 65 Source Folder
Sav Culys G5 Folder
- ¢ Source File
5
Save Al Cul+shiftss | (B Header File
. [7 File from Template
@ Class
Mov
7 Rename. r |03 Bamee
&) Refresh F5 [ Other ctlsN
Convert Line Delim >
Print. cisp
g Import
& Export
Properties Alt+E
Switch Workspace
Restart
Edt
[£ Problems 2 ] Tasks & Console [ Properties Y 8§ =08

Description . Resource  Path Location Type

Kl 4-2 [ AR H

a

@ NucleiStudio_workspace - NucleiStudio 10€
e

e Edit Source Refactor Navigste Search Project Run RV-Took Window Help

8¢ Outline ©2

%) Build Targets

CHTO R QMG -

There ix no active editor that provides an outine.

%) Problems 12 & Tasks [ Console T Properties
0 items

Deseription Resource Path Location Type

K 4-6 SRR H

B & 3-8 frn, FESRH B E DR DOASEIR) R R AR A R A ) SDK &M H:— Board
MK SDK, % FI#5% SoC J Board [/+44. iX H L RVSTAR FF R A, Ff UIX— ik
¥ “GigaDevice->GD32VF103->Nuclei GD32VF103 RVSTAR Board->sdk-

nuclei_sdk@o0.3.7”

o ){—i% “NeXt” iﬁ)\‘l:#—/l-/{:o (i_:I_%E::

X sdk A5 =i il

ARSCAE PR A BRI SR B T, REERBHCR e P al, APHER. S HI sl A SO 2 2 sih o N .
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ASTEAMAH NI S, I HLth ] BEHCHURF € HUAS (1) Nuclei Studio 158D

£ - o x
Refactor Navigate Search Project Run RV-Tools Window Help

[&][o] [ No Launch configurations vl Br&-iDie| @O - E-F it-00 Q-

&5 g Brf-Caro-|m Q ||

(25 Project Explorer 52 BE®Y i -0 S5 Outline 22 (@ Build Targets =g

There are no projects in your wor L

%
o

To sdd a project reating Nuclei RISC-V C/C++ project

@ New Nuclei RISCV C/C: + pf Create Nuclei project

5 Cecate 2 new Makefile projel - Please choose the right development board
& containing existing code

[ Create a new C or C++ proj
F? Create a project.. ~ Nuclei
~ Nuclei FPGA Evaluation Demo SoC
v Nuclei FPGA Evaluation Board
sdk-nuclei sdk @037
 GigaDevice
v GD32VF103
v Nuclei GD32VF102 RVSTAR Board
sdk-nuclei_sdk @0.3.7
+ Sipeed Longan Nano Board
sdk-nuclei sdk @037
v GD32VF103V-EVAL Board
sdk-nuclei sdk @037
v LILYGO TTGO T-Display-GD32 Board
sdk-nuclei_sdk @0.3.7

By lmport projects...

Details
SoC: Nuclei FPGA Evaluation Demo SoC
- Vendor: Nuclei
- description: Nuclei Demosoc Support Package
- core_vendor: Nuclei
- website: Click to view the details
- datasheet: Click to view the details

- usermanual: Click to view the details

BSP: Nuclei FPGA Evaluation Board
- Vendor: Nuclei
- description: Nuclei FPGA Evaluation Board Support Package
- website: Click to view the details
- sch: Click to view the details
- usermanual: Click to view the details
- extra documents:
- MCU200T SCH: Click to view the details
- DDR200T SCH: Click to view the details
- Video Intreduction For MCU200T Board: Click to view the details
- Video Introduction For DDR200T Board: Click to view the details

< Back Einish

Cancel

0 items selected

ive editor that provides an

+B-[-=0

AR N E RSO G RBHOM KA, REURBHRE I, AR sl e A2 A i sl A

K 4-3 PR ar i H KA

BN BRI E ECE T 3-9 B, BN RVSTAR [ A% A2 [ € 1) N205, H X M)
arch #1 abi 73-7)/& rv32imac 1 ilp32, fflh Core EIIABEZ K. [FAFE, RVSTAR &
BRALSZFF—Fh FLASHXIP F##%=0, 1L DOWNLOAD X £t A fe B k. midh
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“Finish” S TFEG

) Creating Nuclei RISC-V C/C++ project m] X

Create Nuclei project

Please select the relevant configuration item

Project name: ‘tes\i
Project Filter by: no filter ~ Filters: ~
Project Example: Coremark Benchmark @app-nsdk_coremark ~
Toolchain: Nuclei GNU Toolchain ~
Nuclei ARCH Extensions: Bitmanip Extension

Packed SIMD Extension

Vector Extension

Download/Run Mode: ILM download mode, program will be download into ilm/ram and run directly in ilm/ram ~
Select NMSIS Library: No NMSIS Library used ~
Standard C Library: newlib nano with printf float ~
Nuclei RISC-V Core: N307FD Core{ARCH=rv32imafdc, ABI=ilp32d) ~
Select Benchmark Options: Options for Nuclei 200/300/600 Series ~

(@' < Back Next = Cancel

4-4 SEFERE PP AR KA DK B LI

® Nuclei Studio A PR A A i) TAEBARAS A [ () SDK Y565, 4140 FreeRTOS #HR
TAESUIIXTRLE) OS W%, Demo_dsp ARk T#2 0] LAY Il NMSIS . kT
NMSIS #4115 HiE 2% (https://doc.nucleisys.com/nmsis/index.html) . X H DL
Demo_dsp N, “Project Example” 14% “baremetal _demo_dsp” . K AfEH
dsp T#¢, FFZEAHM NMSIS &, JirLl “Libraries” &4 “NMSIS DSP” .

® Nuclei Studio A AR #r TR H) e T H 2 3 & TAR R, X Bk £ Al
BATEL, Frbl “NEWLIB” i%£#% “newlib-nano without float” . Zwifiib %%
“Optimization Level” ## “Optimize more (-02) ” . ZJ5i—Hik#F “Next” H
#| “Finish” .
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B Nuclei Studio R PAHRI#EAE S TRE 1) 5L B A% T .

@ CPDE - RVSTAR demo_dsp/applicati
File Edit Source Refactor Navigal

&][0][m] ©Run

& Project Explorer

~ & gd32ef103
Board
Common

RVSTAR demo d:

<
% RVSTAR demo dsp

WL TR 3-10 fias, FAEEE

M TREA, AET AR, %8 “SDK Configuration Tools” 13 B ik T H. .
mE 3-11, WERZBE R PENALEY, Bk “Optimization Level” ¥ “None (-

00) 7, mili “Save” BHUEI. WK 3-12 BRI EEBEUE K TR A T A
SKHL, 1E$E “clean” WEFR— N LA, P T BIARgEE L. ER: SDK
Configuration Tools &2 4w P L & J5 4 R AEC & (Debug Configurations) A4, 1HF
BNAE Bont B AT &

in.c - MucleiStudio

/mai

[EIRVSTAR _demo_dsp_« (=R

8 @mainc

Open in New Window
Show in Local Terminal
Copy
Paste

% Delete
Remove from Contex

Rename..
Import._
Export
Build Project
Clean Project
Refresh
Close Project
Close Unrelated Projec
Build Targets
Index
Build Configurations
Profiling Tools
Validate
© RunAs
# Debug As
Profile As
Restore from Local Histo

rch Project Run RV-Tools Window Help
LAA ST RSB B R

acluda serdine b

3

pc.h*

Qv | _get_rv_cycle

Eycles
: fele;
byele;
F2 tle;

fost = 8;
bred;

Initialized\n");

3
dsp]
o

@ SDK Configuration Tools culte | @

% Run C/C++ Code Analysis
Team
Compare With
Configure
Source

Properties

3

»

Alt+Enter

-

Kl 4-5 77T SDK %8 T A

= Qutline

u stdinth
u stdioh
u nuclei_sdk soch
o ref convh

u riscy_mathh

# READ_CYCLE

«* enter cycl

# BENCH INIT)
# BENCH_START()

# BENCH END()

# BENCH_ERROR(
# BENCH STATUS()
# BENCH FINISH()

8 1ect cany inoat 32 A float 2

- o *
[Quick Acc
LR
~
, v
MmBvmvoo

AN PITIR A BB ER BT, RSP R TIRA, AMSAERR . S Sl e A SO 2 A iR sl A
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@) Nuclei SDK Project Configuration

projectName :

Configuration :

Core :

ARCH :

ABI

Tuning :

Code maodel :
Download :

Select C Runtime Library :
Cptimization Level :
Extra Common Flags :
Extra C Flags :

Extra C++ Flags :
Extra ASM Flags :

Extra Link Flags :

Save

SDK Configuration Tools:1.0.0.1

test

Debug

N307FD

[IBitmanipulation Extension(RVE)
] Cryptography Extension(RVK)
[JPacked SIMD/DSP Extension(RVE)
[JVectar Extension (RVV)

| rv32imafdc

lilp32d

Muclei 300 series(-mtune=nuclei-300-5 ~

Medium Low (-mcmodel=medlow)
ILM
newlib nano with printf float

Cptimize fast(-Ofast)

“

“

-fno-code-hoisting -fno-tree-vectorize —ﬂ||

-x assembler-with-cpp

| -WI,--check-sections

Cancel

K 4-6 2o TR E

AR N E RSO G RBHOM KA, REURBHRE I, AR sl e A2 A i sl A
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@ CPDE - RVSTAR_demo_dsp/application/main.c - NucleiStudio - [ul ®
File Edit Source Refactor Navigate Search Project Run RV-Tools Window Help
[Eloi[=] orun TIRVSTAR demo dsp ¢ R R R R A - R R AT - T DR R - R AR R R R NP D R [Quick Access||| = | B8
Pr@ct Explorer ¢ = 8 @mainc = Qutline
~ 1% RVSTAR_demo_dsp 1 #include <stdint.h> ~ , AR e n
Incl New > u stdinth ~
apg Golnto 5 u stdioh
- nuc n u nuclei_sdk_soch
. NMSIS Open in New Window u ref convh
= Core Show in Local Terminal > 4 e mathih
DSP Copy Ciri+C # READ_CYCLE
= Library Paste CtrisV  |get_rv_cycle w'el
v & SoC ® Delete Delete
v @ gd32vf103 Remove from Context Ctrl+Alt+Shift+Down "
Board Source > ‘ :
Commeon Move le;
RVSTAR demo_dsp.d  Rename 2
N ercd v
'[mp"” =8 # BENCH TRST(
SRt i # BENCH_INIT)
Build Project # BENCH START()
I Clean Project ] © # BENCH_ENDQ
Refresh F5 \ # BENCH ERROR()
Close Project dalized\n") \ # BENCH_STATUS(
jose Unrelated Project A \ # BENCH_FINISH()
1 8 tect cany inont 3 A flaatid ks
Build Targets )l ; NSRS

Index > |
Build Configurations [

Profiling Tools >
Validate
© Run As
# Debug As
Profile As
Restore from Local History.
@ SDK Configuration Tools Ctri+6
# Run C/C++ Code Analysis
Team
Compare With

Configure
Source >

Properties AltsEnter

< >
% RVSTAR demo dsp

Kl 4-7 I8 B AT R 9 1

5. BT H

% B PLIF & #CH Nuclei FPGA Evaluation Board, ¥Afi4b ¥ %8 4% A N3o7(rv32imafc) A
B, VE4H 28 Nuclei Studio H A& 10 H #9755 2.

f£ Nuclei Studio IDE @& 351 H AT LAAT LU R JURRE W7 3
AR B SR

® Xt RPER T, B AT H DI T Nuclei Studio NPK ZhgE, #£FA
%f M ) SDK NPK Zip 1, E[7E Nuclei Studio _FHEAT#AR TREMI A . OOoRBHG IR
fit 7 Nuclei SDK. HBird SDK. SoC IP SDK ff] NPK Zip fi, ¥Ju] 5 \%| IDE it
AT TR B FIE A

B NEHIHEZSACEYIH -

® RREH WM, B, A AW LU AT H RSOk BT ITRARE, S

ARSCAE PR A BRI SR B T, REERBHCR e P al, APHER. S HI sl A SO 2 2 sih o N . Wi 25
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BEAT > AEHE, 7 B T LAE S AN s B B R N ZIE , AT Bt Al ) 8
T H , e b B R B T R B 2.

W EER T BRI -

® XREEBIIII, %IRRT 24k, EHET AR E A MRS .
%07 SR, PP SEbr TAR R EME Y, (Bl w0y e dn v, A
R AVEAN 1A AR AT C B %% IR UNTER A2 o

B T O Makefile G T

o XFh I EEE AT B4 K Makefile o3& HoAhgm 3 T A MINH, #=4L—F7 IDE
g TR, WBHTE, WRIEMN TR, ENMBNEIFRSEMER E, RERTH
IDE 135 .

IR XX LR T Bl T 4

5.1. BEERE 3R H

AT A B anfar 5 AR A B sh 602 H 1) 72, 7E Nuclei Studio IDE €12 —/M& #1% Hello
World i H, VE4PBINT,

B OHE-A TR, LIRSS T, & “File --> New --> New Nuclei RISC-V C/C++
Project” , WK 4-1. 7] LA{E Project Explorer #L ik # “New Nuclei RISC-V
C/C++ Project” , WK 4-2.
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2 ek e - o x
File Edit Source Refactor Navigate Search Project Run RV-Taols Window Help
New AlteShiftN > @ New Nuclsi RISC-V C/C1+ Project f - Y IR T rrrs 5
Open File. [ Makefile Project with Existing Cade
- - Q ®|E
S—Operrhro; 7 e 7
Recent Files > 4 Project = B 3% Oufline ¥ @BuldTargets & § = O
Close Editor Curl+W Convert to a C/C++ Project (Adds C/C++ Nature) There is no active editor that provides an outline.
Close All Editors Cirl+Shift+W | 62 Source Folder
Save Culss |G Folder
> .
. i‘ Source File
Save Al Culsshiftrs | [N Header File
P [ File from Template
@& Class
Move..
7] Rename. 2 | Example
& Refresh F5 [ Other.. Cirl+N
Convert Line Delimiters To >
Print. Curl+P
& Import.
i Export.
Properties Alt+Enter
Switch Workspace >
Restart
Exit
[2] Problems 33 & Tasks B Console [ Properties Y § =8
0 items.
Description Resource  Path Location Type
a
B 5-1 AFERAIERE
@ Nudeistudio_workspace - NucleiStudio 10E - o

Fle Edit Source Refactor Navigate Search Project Run

Al|0l|=

L Project Explorer 11

There are no projects in your workspace

| [No Launch Configurations v/ on v g~ - RN I e T

RV-Tools Window Help

#) Problems i1 & Tasks @ Comsole [ Propertes
0 items.
Description Resource Path Location Type

5-2 Project Explorer 41 E&I& % H

T 8 Outiine 11 ) Build Targets

There is no active editor that provides an outline.

B K g-3 Fow, EEEEE D FusEEm H R, X BIRATE Nuclei FPGA 1R, W2
N307, SDK A nuclei_sdk@0.3.7 FRARM— AT K, EXTHF ) Board )
SDK, M7 “Next” #ANTF—4,

AN PITIR A BB ER BT, RSP R TIRA, AMSAERR . S Sl e A SO 2 A iR sl A Wi 27



R
NUCLEI

=]

Create Nuclei project

Please choose the right development board

v HummingBird
~ HummingBirdv2 RISC-V $oC
~ Nuclei MCU200T FPGA Evaluation Board
sdk-hbird_sdk @0.1.3-dev
~ Nuclei DDR200T FPGA Evaluation Board
sdk-hbird_sdk @0.1.3-dev
~ HummingBird RISC-V SaC
~ Nuclei HummingBird Evaluation Board
sdk-hbird_sdk @0.1.3-dev
w Nuclei
~ Nuclei FPGA Evaluation Demo SoC
~ Nuclei FPGA Evaluation Board
sdk-nuclei_ sdk @0.3.2-dev
v GigaDevice
v GD32VF103
v Nuclei GD32VF103 RVSTAR Board
sdk-nuclei_sdk @0.3.2-dev
w Sipeed Longan Nano Board
sdk-nuclei_sdk @0.3.2-dev
v GD32VF103V-EVAL Board
sdk-nuclei_sdk @0.3.2-dev
~ LILYGO TTGO T-Display-GD32 Board
sdk-nuclei_sdk @0.3.2-dev

Details
SoC: Nuclei FPGA Evaluation Demo SoC
- Vendor: Nuclei
- description: Nuclei Demosoc Support Package
- core_vendar: Nuclei
- website: Click to view the details

Click to view the details

- usermanual: Click to view the details

BSP: Nuclei FPGA Evaluation Board
- Vendor: Nuclei
- description: Nuclei FPGA Evaluation Board Support Package
- website: Click to view the details
- sch: Click to view the details
- usermanual: Click to view the details
- extra documents:
- MCU200T SCH: Click to view the details
- DDR200T SCH: Click to view the details
- Video Introduction For MCU200T Board: Click to view the details
- Video Introduction For DDR200T Board: Click to view the details

B 5-3 AL E R

Cancel

W 5-2 for, K E DR REN TS GER: KREEZEE NPK
Configuration 7B BT ALK TE, AFEK SDK B A FKITRREE A
KB T RS A AR RERRE, HER) .

® Projectname: HiHw#. XHRWEN “1_helloworld”

® Project Example: % Helloworld.

® Toolchains: #1f# 4 Nuclei GUN Toolchain.

® IRMIMMHIZEZE N3oy, ALl “Core” iE#E “N3o7”

® ML IFRMCIRF =R TR, BUR O REA R EE AR f A, X BRI TLM AR

o

B LM FEEREEEEEE A MCU ) ILM F1, 3FM ILM JFE#4T. ILM
1 SRAM 21k, i Ek,

ARSCAE PR A BRI SR B T, REERBHECER S T, AHERE. SR s i A S 2 il oy WA
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B FLASH F#ils 7 AR B Bt ik 29 K Flash [X 8], QRS B (138 48 i ki 2
WAL ILM bk X ], EORE TR PR B 3% T 34E MCU i Flash 1, {H2 EH
Ja BRI 5] AR R AU BRIz 2] ILM o, R M ILM e IAT .« R #ie
HAE Flash #1, Ao ER.

B FLASHXIP F#i R ISR 2 K Flash X 8], =UREFE R EgE B3 e
MCU ff Flash ', JFE#:M Flash 6347 . PSS Flash 1, Ao
E5,

® A 5Ty DAL R AT L B

® fidi“Finish”52 i TFEAI 4.

) Creating Nuclei RISC-V C/C++ project O X

| Create Nuclei project

Please select the relevant configuration item

Project name: 1_helloworld|

Project Filter by: no filter ~ Filters: -
| Project Example: Coremark Benchmark @app-nsdk_coremark w

Toolchain: Nuclei GNU Toalchain ~

Nuclei ARCH Extensions: Bitmanip Extension

Packed SIMD Extension

. ==
Wector Extension

<=

Download/Run Mode: ILM download mode, program will be download into ilm/ram and run directly in ilm/fram ~
Select NMSIS Librany: No NMSIS Library used w
Standard C Library: newlib nano with printf float w
Muclei RISC-V Core: N307FD Core(ARCH=rv32imafdc, ABI=ilp32d) w
Select Benchmark Options: Options for Nuclei 200/300/600 Series v

@' = Back Next = Cancel
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5-2 Fre T H R ARAGE

B e 5-3 fown, IR B 36 Hello World i H 248 58 .

]  workspace - 1_hellowaorld, c- IDE
Fle Edit Source Refactor Navigate Search Project Run RV-Tools Window Help

[&][0][®][0run || 1helloworid debug qems v 1| [+ | B-R-B DS BOE - B - -G H-0-G-Q- @ [ BE

Q eS|

B-fl-vwe-o-m
[ project Explorer 53 = B [8mainc X = B gz Outline 52 (© Build Targets =8
SK-Sr i 1 b/ see LICENSE for license details. ~ PELR o 4 8
% 1_helloworld 2 #include <stdio. U stdioh
- : #include <time.n> o tmeh
< #include <stdlib.n> ime.
5 #include "nucleli_sdk_soc.n” U sdibh
6 U nuclei_sdk soch
7% void print_misa(void) © print misa(void) : void
L # RUN_LOOPS
CSR_MISA Type misa bits = (CSR_MISA Typs) _ RV_CSR_READ(CSR MISA); # RUNLOOPS
1 static char misa_chars[30]: P
S © main(void) : int

©ints_t index = 0:
if (misa_bits.b.mxl == 1)
misa_chars[index++]

misa_chars[index++] = '2';
} else if (misa bits.b.aml == 2) {
misa_chars[index++] = '6';
misa_chars[index++] = '4':
} else if (misa bits.b.mxl
misa_chars[index++]

misa_chars[index++]
misa_chazs[index++]

if (misa bits.b.i) {

misa _chars[index+:] = 'I':

if (misa_bits.b.m) {

misa_chars[index++] = 'M';
¥
if (misa_bits.b.z) {
misa_chars[index++] = 'A':
1 ¥
2 if (misa_bits.b.b) { v

¥ §=8

# Problems 2 | Tasks & Console [T Properties
0 errors, 1 warning, 0 others

Description Resource  Path Location Type

& Warnings (1 item)

| writable | smart Insert |1:1:0 |

Bl 5-3 Se iR 81 1 H

B AL E A S A “Project—> Build Project” mf “ (8 ek, SRorhi%I E kAT
PPk, MiFEUIE 5-4.
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=] iStudio workspace - 1_helloworld/applicati in.c - istudio IDE - o X
file Edit Source Refactor Navigate Search Project Run RV-Tools Window Help
[&][e][8] @fn | [ 1ot debug qems v 0] (- H G 88RO CBOE B E-G H 0B @E - AFE T
Hr-FH-CPorD A o 3|
&5 Project Explorer & =8 = O 5= Outline 52 @ Build Targets = g
B% Y & AzTails. ~ FEERY o % §
1% 1_helloworld U stdioh
s #include ctime.n> P
4 #include <stdlil & timeh
5 #include "nuclei_sdk_soc.h” U sulibh
6 o nuclei sdk sach
79 void print_misa(void) © print misa(void) : void
{ # RUN_LOOPS
CSR_MISA Type misa bits = (CSR MISA Type) _| RV CSR READ(CSR MISA);: # RUN LOOPS
static char misa_chars[30]: void) i
iinte ¢ indsx = 57 ®  main(void) : int
if (misa_bits.B.mxl == 1) {
misa_chars[index++] = '3';

misa_chars[index++] =
} else if (misa bits.b.mxl
misa_chars[index++] =
misa_chars[index++] =
} else if (misa_bits.b.mxl
misa_chars[index++] =
misa_chars[index++] =
misa_chars[index++] =

if (misa_bits.b.i) {

i charatindeees] = 170
[2] Problems ] Tasks [ Console 52 [ Properties & &[5l A ER #B8-5-=8
CDT Build Console [1_helloworld]

Invoking: GNU RISC-V Cross Create Flash Image -
riscv-nuclei-elf-objcopy -0 ihex "1 _helloworld.elf" "1 helloworld.hex"

Finished building: 1_helloworld.hex

Inveking: GNU RISC-V Cross Create Listing
risev-nuclei-elf-chidump --all-r nangle --line-n —-wide "1_nelloworld.elf" > "1_helloworld.lsc!
Finished building: 1_helloworld.lst

Invoking: GNU RISC-V Cross Print Size
riscv-nuclei-elf-size --format=berkeley "1_helloworld.elf"
text data bss dec hex filename
25998 560 2250 28848 70b0 1_helloworld.elf
Finished building: 1_helloworld.siz

11:33:16 Build Finished. 0 errors, 0 warnings. (took 53.535ms)

Writable Smart Insert 9:48:193 S

5-4 5ERIH g 1%

B K 5-5 i, {E Hello World 5 H B304 Bad #29r,  Hox M) OpenOCD ft & CL 4 [A]
A, EWHMIETEE, AP UAS A H SR “Hello World” , sl
“Debug As —>Debug Configurations” Jf /& AL & k21T & H . Debug 5 Run f#
FAAR A F B & S, ATl “Run As —>Run Configurations” 17
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@ CPDE - 1_helloworld/application/main.c - NucleiStudio

- 9 x
File Edit Source Refactor Navigate Search Project Run RV-Tools Window Help
&|[0][=] ©Run + @1_helloworld_debug o~ B A A GOSN A ST e v O TR ATINE SISy LR [Quick Access] | = | B
& Project Explorer = =&le 770 @mainc £ Outline s ild Tar... Docur
~ & 1_helloworld e Tt pense details. X vEARV e
 Binaries u stdioh
 Includes Celkno 4 timeh
« & application Open in New Window oc.h® u stdiibh
4 maine Show in Local Terminal > u nuclei_sdk soch
& Debug o print_misafvoid) - voicl
- &nudel sdk | 'C‘TW ‘cwf = main(yoid) : in
: _bits = (CSR_MISA_Type) __RV_CSR_READ(CSR_MISA);
NMSIS % Delete Delete  [hars[30];
SoC ; - . B
Remowe from Context Ctrl+Alt+Shift+ Down
Thelloworld ¢ g0 o Sk e 11
Move lex++] = '3°;
s ax++] = "2
Rename. F2 §ts.b.ma
& Import. ex++] = 6’
Export.. exit] =
ts.b.mxl
Build Projects exet] = ©
Clean Project “::] =2
Refresh pg fexel =
Close Project
Close Unrelated Project ex++] = 'I°; v
Build Targets > B
Index > _ e . LU
Build Configurations >
rld. elf o
Profiling Tools > B ees Linker
Validate h=rv32imafc -mabi=ilp32f -mcmodel=medany -msmall-data-limit=8 -02 -ffunction-sections -fdata-sections -fno-common -g -T "D:\CPDE\1_helloworld\nuclei_sdk\SeC\hbir
Run As 5 | 1_helloworld.elf
3| @ 1C/C++ Container Application
Profile As > [ 2 Local C/C++ Application } owor1d. hex"
Restore from Local History... Debug Configurations...
@ SDK Configuration Tools Clil+6 o
4 Run C/C++ Code Analysis Create Listing . .
. , r-source --all-headers --demangle --line-numbers --wide "1_helloworld.elf" > "1_helloworld.lst"
bworld. 1st
Compare With »
Configure Print Size
5 rmat=berkeley "1_helloworld.elf"
Source 51 dec  hex filename
" 1le134 2796 1_helloworld.elf
Properties . AltsEnter | 0% ei
20:86:52 Build Finished. @ errors, 8 warnings. (took 35.629ms)
v

1 helloworld =]

K 5-5 JF )3 R BUC & ik

B WE 5-6 fon, AT AR MECE X “Hello World_Debug_OpenOCD” .48 H 5
AR e TE RS 19 R 38 45 & OpenOCD HHAT F#AIH A 5%, ATLIEEE 7
TRHAT TR T AR
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@ Debug Configurations O X
Create, manage, and run configurations ﬁ\
EEYEIIEER Name:‘17hech0r\d7debugiopenocd |
type filter text [ Main - % Debugger| & Startup % Source [ Common| % SVD Path
[€] C/C++ Application .
[€] C/C++ Attach to Application loice:
[E1C/C++ Container Launcher ‘LheHowcr\d Browse...
[ C/C++ Postmortem Debugger C/C++ Application:
[€] C/C++ Remote Application ‘Debugﬂ helloworld.elf
Cit C/C++ Unit =
=1 GDB Hardware Debugging Variables... | Search Project... Browse...
v [E1GDB OpenOCD Debugging Build (if required) before launching
El 17he|low0rldideblfgiupenocd Build Configuration: Select Automatically ~
€1 GDB PyOCD Debugging
1GDB QEMU Debugging (O Enable auto build (O Disable auto build
€1 GDB SEGGER J-Link Debugging (® Use workspace settings Configure Workspace Settings...
@& Launch Group
# Launch Group (Deprecated)
Filter matched 14 of 15 items Reverl ATl
@ Close

5-6 Hz3hA R OpenOCD it &

5.2. AWEHAHHEZEIS AR

KA EANABanf i IDE NEF T H BHESACEHTIH, AL N3oy B3 H B N EET
SN, THAENE Chttps://github.com/riscv-mcu/Nuclei-Studio IDE-Project-Package) .
B 5-7 s, eI HAIE S OREHEEEAR,

fE£3ET Windows ] Nuclei Studio IDE JF &I, Wi L H R “ TR FahtldE TR,
AR EINEUE I H B A A nuclei-sdk XY, MCH B SE T —TH BAKNH

[E] README.md Update README.md

[E] nuclei-eclipse_demo.rar update package

5-7 fiT github A5 H

ARSCAE PR A BRI SR B T, REERBHCR e P al, APHER. S HI sl A SO 2 2 sih o N . T 33
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# nuclei-eclipse_demo.rar K450 F LG, NAEWE 5-8 B, 43 008:

FEHR BN HES e

settings 2020/8/5 17:46 pvgl=c

application 2020/8/5 17:46 g ey

nuclei sdk 2020/8/5 17:46 LS
] .cproject 2020/8/5 17:46 CPROJECT 324
| .project 2020/8/5 17:46 PROJECT {4
" | hello_world debug openocd.launch 2020/8/5 18:11 LAUNCH 3244

5-8 FFAKITH
B i H IR S .setting, .project Fl.cproject
B Ui H 8K Debug W E 3 f*.launch
B nuclei_sdk 043k
BRI AF TR 73 SDK YA
B application 4%
455 hello_world #4125 ) main b8 HOJEACAD .

P RATEERIEE, AR
B EEREHERE “File—>import” .

B 0 5-9 fius, #EF#F “Existing Project into WorkSpace” J&, Al “Next” .

AN PITIR A BB ER BT, RSP R TIRA, AMSAERR . S Sl e A SO 2 A iR sl A T 34
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@ Import O x
Select

Create new projects from an archive file or directory.

Select an import wizard:
type filter text
v & General
& Archive Fil
= Existing Projects into Workspace
3 File System
T Preferences
2 Projects from Folder or Archive
e CfC++
= Git
& Install
& Oomph
& RPM
& Run/Debug
= Tasks
& Team
e TextMate
@ Tracing
&= XML

@ <Back Finish Cancel

K 5-9 i AR

B A “Browse” , EFFESARNIHEKAE, WK 5-10 s,

@ Import O

X
Import Projects J;L/
N . N . ’
Select a directory to search for existing Eclipse projects.
(®) Select root directory: H v ‘I Browse... I
(O Select archive file: Browse...
Projects:
Select All
Deselect All
Refresh
Options

[] Search for nested projects

] Copy projects into workspace

[] Close newly imported projects upon completion
[ Hide projects that already exist in the workspace

Working sets

[CJAdd project to working sets New...
Working sets: Select...
@ < Back Next > Finish Cancel

K 5-10 & # 7 ZE T AR H
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B HESARIE &I IDE 35, il “Finish” 41 5-11 fos

& Import

Import Projects

Select a directory to search for existing Eclipse projects.

O

X
=
7|

(® Select root directory:l DACPDE\hello_world

VI| Browse... |

() Select archive file: Browse...
Projects:
hello world (DACPDE\hello_world) Select All
Deselect All
Refresh
Options
[]Search for nested projects
[ ] Copy projects into workspace
[ Close newly imported projects upon completion
[ Hide projects that already exist in the workspace
Working sets
[] Add project to working sets New...
Working sets: Select...
@ < Back Next > Finish Cancel

B 5-11 Pl E S AR IH

AR N E RSO G RBHOM KA, REURBHRE I, AR sl e A2 A i sl A
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B {f IDE I H SIHEHEBHERBAIHPEHRXRESEHWE 5-12 fix. cAIHERIAN
N307 HI4mi%1ET, Nuclei SDK 1V 17 helloworld 18 FH 2 0. 7525 £ 1) Nuclei
SDK J56%1% 75 7] Github Chttps://github.com/riscv-mcu/hbird-sdk) FREEIS

v 1= hello_world
il Includes
= application
& nuclei_sdk
= hello_ world _debug openocd.launch

B 5-12 SR H i 4
5.3. TERFIEIEHRE

A F A B A 4 -5 77 207 Nuclei Studio IDE 67—/ 2 52 X Hello World i H
(AREVUER, BiER NPK 53 . J &N Nuclei FPGA Evaluation Board, W%~
N307. ZHiEE T eI H 240, EF BEFahE SMERmgeE, HEAP3RnT.

5.3.1. FFEI2W B
B 7ESEHRE LR “File—> New —> C/C++ Project” . fKE 5-13 Fi/R.
B 5-14 PR, EFRRRE DR RGE T 2.
® Project name: WiH 4.

® Use default location: WIRZJE T ik i, 248 FHERIA Workspace U A7 Ik
TiH .

® Project type: i%£# “Hello World RISC-V C Project”
SR G s Next it N K —2
B K 5-15 fow, fEFRHEE i E Hello World 1 H B3 A1E &

® ffiffk “Source” WEIIAR A, HIEHD “Next” BENT D,

AN PITIR A BB SR T BT, RSP RS, AR R sl e A SO 2 Al el 2y A W 37
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B 5-16 fow, RS E H P E I H AR ECE A AT E 1 .

o DA LMEMEMS EAMAEMIZE, HREA L “Next” #HAT D,
W RS R OB E I P 1 RISC-V L H 4.

o UAENE, HEEESE “Finish” , RIE5EMK I Hello World i H #1612 .
B Q5 Hello World T B FHETA0E 5-17 Fizs.

B HiE— application XFF., WK 5-18, 7& LFEAA 7% FF New —> Folder, #iiA\
application, it “Finish” SEpUH# TR, WE 5-19. K main.c #6A application 3
PF R 5E AT 3 3

@ CPDE - NucleiStudio - [« ®
[ )it source Refactor Navigate Search Project Run RV-Tools Window Help

2% @ Erar G it v O R NE § i o [Quick Access|| o | 8
Open File...
. Open Projects from File System.
Recent Files 3 Bl Convert to a C/C++ Autotools Project
. B Convert toa C/C++ Project (Adds C/C++ Nature)
W @ so

Folder

¢ Source File

+ Header File
File from Template

= Project... % Outline
An outline is not available.

n
wrce Folder

© Class
Task
o Example..
F5 [ Other_ cul+N
wert Line Delimiters To

ri+P
Import...
Export..
Properties Alt+Enter

Switch Workspace
Restart
Ext

© Console
Mo consoles to display at this time.

K 5-13 & C/C++ Project

AN PITIR A BB ER BT, RSP R TIRA, AMSAERR . S Sl e A SO 2 A iR sl A T 38
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®

C Project
Create C project of selected type

Project name:l 2_helloworld

Use default location!|
Location: DACPDE\2_helloworld

Choose file system: [default

Project type:

Browse...

GNU Autotools

Executable

@ Empty Project

& Hello World ANSI C Project

@ Nuclei SDK Project For GD32VF103 SoC

@ Nuclei SDK Project For HummingBird SoC
Shared Library
Static Library
Makefile project

< >

| RISC-V Cross GCCf

Show project types and toolchains only if they are supported on the platform

®

Finish

Cancel

K 5-14 & & C Project Jil H 44 f12k 1Y

e

Basic Settings

Basic properties of a project

Author ‘

Copyright notice ‘Your copyright notice

Hello world greeting ‘Hello RISC-V World!

Source I\

Linker other options: ‘

@

Finish

Cancel

5-15 ¥ & Hello World T H 3£ 445 B,

AR N E RSO G RBHOM KA, REURBHRE I, AR sl e A2 A i sl A
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(&) O X

Select Configurations s
Select platforms and configurations you wish to deploy on o
Project type: Executable
Toolchains: RISC-V Cross GCC
Configurations:

&% Debug Select all
1% Release
Deselect all
Advanced settings...

Use "Advanced settings” button to edit project's properties.

Additional configurations can be added after project creation.
Use "Manage configurations” buttons either on toolbar or on property pages.

@ < Back Finish Cancel

Bl 5-16 W EIH KR sl A AL & 1

@ CPDE - 2_helloworld/main.c - NucleiStudio

[« X
File Edit Source Refactor Navigate Search Project Run RV-Tools Window Help
%[0/[=] ORun ) myProj Debug o~ CRE S RA-IRVESE SR R AR XA RS A R AR AN S TR S LR TR R Quick Access|!| |8
& Project Explorer g = 2 EOutline » b "
2 helloworld ~ rEARE e R
# Includes “ stdioh
@ main.c * main(void) : ir
#include <stdio.h>
* Demonstrate how to print a greeting message on standard output
and
s a build-only project. Do not try to run it on a
, since it lacks the dev specific startup
22 main(void)
23 {
24 printf("Hello RISC-V World!™ "\n"); v
ks © Console - 2 Ai®Qvy
CDT Build Console [2_helloworld]
2 helloworld

K 5-17 6528 Hello World 35 B f#) % 1
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@ CPDE - 2_helloworld/main.c - NucleiStudio - o X
File Edit Source Refactor Navigate Search Project Run RV-Tools Window Help
%/[0][®] 0Run 5 myProj Debug =hs B RSP ON WD A E LG HE YO A ATISE v Sy cflveevey [Quick Access|!| @ | B
& Project Explorer : X 4 main.c © 2 & Outiine 2 a
vs2 ~ rERRY o R
S incid New 3 Project.. - u stdioh
@ main GO Into File = main(void) : int
Open in New Window ﬁﬂiﬂﬂﬁmﬂiﬂ
Show in Local Terminal >
@ Class
Qri+C i Header File
CUlV ¢ Source File
Delete o Source Folder
Ctri+Alt+Shift+ Down = (/(qu]e(l
’ & Convert to a C/C++ Project (Adds C/C++ Nature)
4 pp T Bample
i CulsN
& Import.. Y project. Do ¥ To run it on a
: Export.. i ific startup.
Build Project
Clean Project
Refresh 5
Close Project
Close Unrelated Project 0 RISC-V World! \n"); Y
Build Targets = =
g Console k@Y
Index >
ielloworld]
Build Configurations >
Profiling Tools >
Validate
© RunAs >
% Debug As >
Profile As >
Restore from Local History...
@ SDK Configuration Tools cule6
# Run C/C++ Code Analysis
Team >
Compare With >
Configure >
Source >
Properties Alt+Enter
52 helloworld & ® @
5 5- BRSO
Kl 5-18 ;
€ New Folder O K
Folder

Create a new folder resource.

Enter or select the parent folder:
2 helloworld

e =
» =2 _helloworld

Folder name: application\

Advanced >>

2

Kl 5-19 SERGHT gk
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5.3.2. FE B H 1 nuclei_sdk

AT AT nuclei_sdk MMAZITE F1, SDK B EAR N BEARCAMIEM N H, nlhSH
https://doc.nucleisys.com/nuclei sdk/index.html. #1575 E4#H SDK ) H A 4, 2
Github K2 # ) Nuclei SDK ¥EfY (X H L 0.3.7 A NG , HEEITE:
https://github.com/Nuclei-Software/nuclei-sdk/releases . AT /24K nuclei_sdk H
helloworld 7 2K SCAF I BT H (25, BARDIRAT .

® i}t A\ Nuclei Studio [ 2_helloworld Wi H, #HanF EEIN nucleisdk J5 04

¢ K 5-20 s, 1E Project Explorer #29i%H 2_helloworld T H, #. RbsA
B, % “Properties” FTIF AL E W .

& WE 5-21 s, E#HHKE OB #HD “Resource” , EA4 A Location £ H
A &L B br =, &5 SO % D3k 2_helloworld i H 7S04
Jefi B o

& HHE 5-7 AR nuclei-eclipse_demo.rar K456 H I nuclei_sdk SC#F 32 5 il
BT 2_helloworld Wi H B HR T, WK 5-22 fizR.

€ [1%) Nuclei Studio, 7E Project Explorer £+ 2_helloworld Wi H, i fbr
Fgk, %P “Refresh” , WE 5-23 iR,

& Refresh 2 J5 2_helloworld Ti H i) F{# 0] LL&E F) nuclei_sdk 43, UK 5-24
Fix, ZEMHE5ER T nuclei sdk JE LRI A

ARSCAE PR A BRI SR B T, REERBHECER S T, AHERE. SR s i A S 2 il oy WA WG 42
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@ CPDE - NucleiStudio
File Edit Source Refactor Navigate Search Project Run RV-Tools Window Help

4|0 [=| ORun

& Project Explorer :
~ 1 hello_world
 Binaries
# Includes
& application
& Debug
& nuclel sdk
hello_world_

@ hello_world_debug o (=8 LRSS R al-1aY

e

New >
Go Into

Open in New Window

Show in Local Terminal »
Copy CtriaC
Paste Ctri+V
Delete Delete
Remove from Context Ctrl+Alt+Shift+ Down
Source >
Move

Rename.. 2

s Import...

# O

%0

Export

Build Project

Clean Project

Refresh F5
Close Project

Close Unrelated Project

Build Targets >
Index »
Build Configurations >
Profiling Tools >
Validate

Run As >
Debug As >
Profile As >
Restare from Local History..

SDK Configuration Tools Ctrl+6
Run C/C++ Code Analysis

Team >
Compare With >
Configure >
Source >

e
el

Properties AltsEnter |

WA TE T v ETHETOTR AT &S

* B Qutline

An outline is not available.

K 5-20 7 T2 % B 4% 0 01 1

@ Properties for hello world

C/C++ General
Linux Tools Path
MCU

Project Natures
Project Referenc
Run/Debug Seti
Task Repository
Task Tags
Validation
WikiText

Last modified: 2020628 56H T48:09:33
Text file encoding

(® Inherited from container (GBK)

() Other: GBK

[] Store the encoding of derived resources separately

New text file line delimiter
(®) Inherited from container (Windows)
(O Other: Windows

type filter text Resource ’
{Resource] Path: /hello_world
Builders Type: Proiect
C/C++ Build S e
Location: D:\CPDE\hello world

Restore Defaults Apply

Apply and Close Cancel

5-21 fEFH & Lk hello_world 5T H ()30 A &

[Quick Access||| = | B

s} *

~Evs

AR N E RSO G RBHOM KA, REURBHRE I, AR sl e A2 A i sl A
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.settings

application

2020/8/517:46
2020/8/5 17:46

S
S

L

nuclei sdk

2020/8/5 17:46

{3 I

O
O

' | hello world_debug_openocd.launch

@ CPDE - myProj/src/main.c - NucleiStu

.cproject
.project

udio

2020/8/517:46
2020/8/5 17:46
2020/8/5 18:11

5-22 ¥ nuclei_sdk 3032

File Edit Source Refactor Navigate Search Project Run RV-Tools Window Help

%][o][=] -
& Project Explorer =
& muProi
New
Golnto
Open in New Window
Show in Local Terminal
w Copy
Paste
% Delete
Remove fram Context
Source
Move._.
Rename...
& Import...
i Export..
Build Project
Clean Project

__Refresh

Ctri+C

CtrlsV

Delete

Crl+Alt+Shift+ Down
»

Close Praject
Close Unrelated Project
Build Targets
Index
Build Canfigurations
Prafiling Tools
Validate
© RunAs
4 Debug As
Prafile As
Restore from Local Histary..
@ SDK Configuration Tools
% Run C/C++ Code Analysis
Team
Compare With
Configure
Source

Properties

= myProj

Ctri+6

Alt+Enter

~ | No Launch Configurations - on: -

»

=R R e - N S-S T R R SR R I AR A =i
& main c
107®
3 Name : main.c
4 Author
5 Version
6 Copyright : Your copyright notice
7 Description : Hello RISC-V World in ¢
8
18
11 #include <stdio.h>
12
13=/

14 = Demonstrate how to print a greeting message on standard output
15 * and exit.

17 * WARNING: This is a build-only project. Do not try to run it on s
18 = physical board, since it lacks tha device specific startup

18 */

20

214

nt
22 main(void)

3 {
4 printf("Hello RISC-V World!™ "\n");
5 return 8;

lems sks @ Console per
GNU MCU Eclipse Packs console

Loading repos summaries...

Parsing cached content file "D:\Packages\.cache\.content_www_keil_com_pack_index_pidx.xml"...
File does not exist, ignored.

Identifying installed packages...

Found no installed packages.

Completed in 3ms.

Mo installed packages.

Completed in 3ms.

Kl 5-23 Bl¥ L

CPROJECT 3t
PROJECT 344
LAUNCH 3744

= 0 & Outline = sk

u stdioh
= mainivoid) - int

- =] x

[Quick Access|| == | &
=n

LR I

AR N E RSO G RBHOM KA, REURBHRE I, AR sl e A2 A i sl A
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v == 2 helloworld
m Includes
v (= application
g main.c
v = nuclei_sdk
v = NMSIS
= Core
v = 5S0C
v = hbird
= Board
v = Common
= Include
= Source

el 5-24 BRAEBIH H%F 01k
5.3.3. FEE T H K4 B e B IE I
T AL PR RENS 7 B g P, 22 G B G P R A T

TR AT RE NSRRI GCC T HAEMH FIED, S57F Linux M85 A i
(IR A8 I S8 ARSI IR 4

B B 2 F 5 R T ) P IR T
B 7f Project Explorer #:71i% 4 hello_world Wi H , i Arf#, #%4%F “Properties” .

B EEEME AT, BIF C/C++ Build 325, Hifi “Setting” , 7E4 M Tool Settings
HAdt r e

B 0K 5-25 ffion, % Target Processor, FRATHINZ 2 N3o7, [R5 B 42 08 K sz ik
BCE IR, 29T,

® Architecture: i%# RV32l.,

ARSCAE PR A BRI SR B T, REERBHECER S T, AHERE. SR s i A S 2 il oy WA T 45
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® Multiply extension (RVM) : FH4Jik,

® Atomic extension (RVA) : F4ik.

® Compressed extension (RVC) : 754)ik,

® Integer API: #%# “ILP32” .

® Floting Point ABI:

® Code model: iE#*

o A TNAM “Apply” %4,

1% F% single precision

“Medium Any” .

type filter text

Resource
Builders
wv C/C++ Build
Build Variabl«
Environment
Logging

Tool Chain Ec
C/C++ General
Linux Tools Path
MCU
Project Natures
Project Referenc
Run/Debug Seti
Task Repository
Task Tags
Validation
WikiText

@ Properties for 2_helloworld

Settings

Configuration: Debug [ Active ]

~ | ' Manage Configurations...

% Tool Settings ® Toolchains M Devices O Container Settings # Build Steps Build Artifact & Binary Parsers @ Error Parsers

I@ Target P rocessorIQ

& Optimization
& Warnings
& Debugging
® GNU RISC-V Cross Assembler
2 Preprocessor
% Includes
@ Warnings
3 Miscellaneous
~ ® GNU RISC-V Cross C Compiler
2 Preprocessor
@2 Includes
2 Optimization
@2 Warnings
& Miscellaneous
~ ® GNU RISC-V Cross C++ Compiler
2 Preprocessor
% Includes
(2 Optimization
@ Warnings
& Miscellaneous
GNU RISC-V Cross C++ Linker
2 General
= Libraries
% Miscellaneous
~ ® GNU RISC-V Cross Create Flash Image
& General
~ ® GNU RISC-V Cross Create Listing
% General
GNU RISC-V Cross Print Size
¢ General

<

<
@

<
@

o

IArchitecture RV32I (-march=rv32i*) v
Multiply extension (RVM)
Atomic extension (RVA)

Floating point Single precision extension (RVF) »
Compressed extension (RVC)

Integer ABI ILP32 (-mabi=ilp32*) 4
Floating point ABI |Single precision (f) hd
ITuning Toolchain default ™
Code model Medium Any (-mcmodel=medany) ~

Small data limit |

Align Toolchain default (-mtune) b
(] Small prologue/epilogue (-msave-restore)
Force string operations to call library functions (-mmemcpy)
] Allow use of PLTs (-mplt)
[ ] Floating-point divide/sqrt instructions (-mfdiv)

Other target flags ‘

(4]
Restore Defaults l Apply I

Apply and Close, Cancel

5-25 fic & Target Processor &1

B & 5-26 ffion, iE&H “Optimization” , %M & s )ik o B e 1
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® Optimization Level: i%#% Optimization Most (-02).
® fRKiKzik:

€ Function Sections (-ffunction-sections)

€ Data Sections (-fdata-sections)

€ No common unitialized (-fno-common)

. FIRIET NE K GCC iRt ie I, &M BT8R GCC Tt 7 &
s

o A TNAM “Apply” %4,

€ Properties for 2_helloworld O s
type filter text Settings Cvovy
Resource
Builders —
« C/C++ Build Configuration: |Debug [ Active] ~ Manage Configurations...
Build Variabl«

Environment Ny
® Tool Settings ® Toolchains B Devices 0 Container Settings # Build Steps Build Artifact & Binary Parsers @ Error Parsers

Logging
2 Target Processor © | Optimization Level Optimize more (-02) hd
Tool Chain Ec [;:Optimization (2] [] Message length (-fmessage-length=0)
= =
E_/CJrJrTGS‘nT;a‘h Z‘Warmng.s []'char' is signed (-fsigned-char)
inux Tools Patl & Debugging Function sections (-ffunction-sections)
MCU ~ ® GNU RISC-V Cross Assembler . .
. Data sections (-fdata-sections)
Project Natures 2 Preprocessor N itialized (-fi
Project Referenc & Includes 0 common unitialize ¢ not(c?mmon) i
Run/Debug Seti & Warnings [1Do not inline functions (-fno-inline-functions)
Task Repository & Miscellaneous [] Assume freestanding environment (-ffreestanding)
Task Tags ~ ® GNU RISC-V Cross C Compiler [] Disable builtin (-fno-builtin)
Validation & Preprocessor []Single precision constants (-fsingle-precision-constant)
WikiText @& Includes [] Position independent code (-fPIC)
@& Optimization [] Link-time optimizer (-flto)
& Warnings [] Disable loop invariant move (-fno-move-loop-invariants)
& Miscellaneous Other optimization flags ‘
~ ® GNU RISC-V Cross C++ Compiler

@3 Preprocessor
@2 Includes
@2 Optimization
¢ Warnings
2 Miscellaneous
~ ® GNU RISC-V Cross C++ Linker
& General
& Libraries
& Miscellaneous
~ ® GNU RISC-V Cross Create Flash Image
¢ General
~ ® GNU RISC-V Cross Create Listing
& General
~ ® GNU RISC-V Cross Print Size
& General

(4]

@ B Restore Defaults -
@ Apply and Close| Cancel

K 5-26 fi B Optimization &I
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B E 5-27 fius, %9 Debugging, 4 M B A AR ) Gk id B kT,

® Debug Level: #£# Default (-g)-

® it MM “Apply” 4.

519009

type filter text
Resource
Builders
+ C/C++ Build
Build Variabl«
Environment
Logging
o
ain Ec
C/C++ General
Linux Tools Path
Mcu
Project Natures
Project Referenc
Run/Debug Setl
Task Repository
Task Tags
Validation
WikiText

@ Properties for myProj

Settings

Configuration: Debug [ Active |

® Tool Settings # Toolchains M Devices O Container Settings # Build Steps

Build Artifact @ Binary Parsers @ Error Parsers

~ | Manage Configurations...

& Target Processor
& Optimization
(2 Warnings
[ochugais] @
~ ® GNU RISC-V Cross Assembler
2 Preprocessor
& Includes
& Warnings
2 Miscellaneous
~ ® GNU RISC-V Cross C Compiler
2 Preprocessor
& Includes
& Optimization
2 Warnings
2 Miscellaneous
~ ® GNU RISC-V Cross C Linker
& General
& Libraries
2 Miscellaneous

¢ General

~ ® GNU RISC-V Cross Create Listing
& General

~ ® GNU RISC-V Cross Print Size
= General

e

~ ® GNU RISC-V Cross Create Flash Image

Debug level Default (-g)

Debug format
[] Generate prof information (-p)
] Generate gprof information (-pg)

Toolchain default ¥

Other debugging flags ‘

[4)
Restore Defaults Apply

Apply and Close|

Cancel

5-27 fic @ Debugging %7

B %" GNU RISC-V Cross C Linker 1] General.

® Nl 5-28 fiw, RN D IR E R T B IA

& kA BRI iR,

& EFHE DT HRD “Workspace” 12441 .

& XHEFAEH HummingBird PFAEH, i BLAT UL ILM T 808 2006 B
gee_hbird_ilm.1d SCfF. ESRH I % #E NucleiStudio SCfH 111

ARSCAE PR A BRI SR B T, REERBHCR e P al, APHER. S HI sl A SO 2 2 sih o N .
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nuclei_sdk/SoC/hbird/Board/hbird_eval/Source/GCC {43 T
gee_hbird_ilm.1d CfF. HAD B DI LA SO, &SN AT, 1
A B QS Pri ik #E

® gcc_hbird_ilm.1d JAKFE 7 ACIY BRI WA ILM (b hEIX (8], BRE R K
W E R N EE MCU (19 ILM 77, Jf A ILM FF46347. ILM f SRAM 4H %,
SpaE R

® gcc_hbird_flash.ld FIAFE P B EE bk 24 3R Flash [X 8], EEARAD BEHY
WL AR ILM bk X 8], SRR R4 B T 3 MCU 1Y
Flash v, {H:2 b r )5 EZi81d 5] SRS Bz 2 ILM 285 A ILM
O IR IRAT

® gcc hbird flashxip.ld BIASHEFACHS BL 20K Flash [X[H], SURER TR H
P R #AE MCU ff) Flash 4, 3 B4 M Flash 4T . FEF#EES 7E Flash
H, Ao ER.

o HPmUZIEH T RIEBFA G EIIA ., R REIERE
gee_hbird_ilm.1d 1F MR,

& EEHERDA NN “Apply” %4
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N 5-29 Pon, 1% E PR A GG BT,

@ Properties for 2_helloworld

type filter text Settings
Resource
Builders

v C/C++ Build

Build Variabl«

Environment

Loggi

Configuration: Debug [Active ]

® Tool Settings ® Toolchains M Devices 0 Container Settings . Build Steps

~ | Manage Configurations...

Build Artifact [ Binary Parsers @ Error Parsers

(1] & Target Processor Script files (-T) [3]

Tool Chain Ec & Optimization ‘
C/C++ General & Warnings @ File selection O X
Linux Tools Path & Debugging |
Mcu v B Add file path Select one or more Workspace Files
Project Natures
Project Referenc File: v & 2_helloworld A
Run/Debug Seti ‘ & settings
Task Repository = application
Task Tags v g v & nuclei_sdk
Validation & NMSIS
WikiText v = SoC

0 o ~ & hbird
Cancel File syster + = Board
EFIVIISCernaneous 1 v = hbird_eval
v ® GNU RISC-V Cross C Linker & Include
o v & Source
@ Libraries ~ = GCC
& Miscellaneous 5 gee_hbird_ddr.ld
~ & GNU RISC-V Cross Create Flash Image
= General
~ ® GNU RISC-V Cross Create Listing
% General 5 openocd_hbird.cfg v
v (ir‘“g RISC"V Cross Print Size [] Do not use standard start files |
£ benera [1Do not use default libraries (-n( 9
[INo startup or default libs (-nos @ I OK I ‘ e ‘
Remove unused sections (-Xlin|
rint removed sections (-Xlinker --print-gc-sections;
[Jpri d sections (-Xlink i ions)
] Omit all symbol information (-s) 0
< > Restore Defaults Apply
@ Apply and Close| Cancel

Kl 5-

Do not use standard start files (

28 JL B HEH A
A .

-nostartfiles) -

Remove unused sections (--gc-sections).

B T AR “Apply” %74

DRI
=

R il A B GCC Bk, I BAT & B GCC T 1 & 3.

AN PITIR A BB ER BT, RSP R TIRA, AMSAERR . S Sl e A SO 2 A iR sl A
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type filter text
Resource
Builders
v C/C++ Build
Build Variable
Environment
Logging
Settings
Tool Chain Ec
C/C++ General
Linux Tools Path
MCu
Project Natures
Project Referenc
Run/Debug Setl
Task Repository
Task Tags
Validation
WikiText

®

@ Properties for myProj

Settings

Configuration: Debug [Active ]

% Tool Settings ® Toolchains B Devices O Container Settings # Build Steps

~ |Manage Configurations...

Build Artifact & Binary Parsers @ Error Parsers

<

~

<

& Target Processor
(& Optimization
& Warnings
& Debugging
® GNU RISC-V Cross Assembler
( Preprocessor
& Includes
¢ Warnings
# Miscellaneous
& GNU RISC-V Cross C Compiler
( Preprocessor
& Includes
& Optimization
& Warnings
& Miscellaneous
& GNU RISC-V Cross C Linker
# General
& Libraries
2 Miscellaneous
& GNU RISC-V Cross Create Flash Image

Script files (-T) 28 8

"${workspace loc:/${ProjName}/nuclei sdk/SoC/hbird/Board/hbird eval/Source/(

% General
~ & GNU RISC-V Cross Create Listing < >
5
© ENGUEETSVS‘ Ve Print Si | Do not use standard start files (fnostartﬂ\es)l
v _
& General ross Frint Size Do not use default libraries (-nodefaultlibs)
[INo startup or default libs (-nostdlib)
|| Remove unused sections (-Xlinker ffgcfsedh)ns)l
L[ Print removed sections (-Xlinker --print-gc-sections)
] Omit all symbol information (-s)
Restore Defaults Apply

Apply and Close

Cancel

m & 5-30 fion, ¥t GNU RISC-V Cross C Linker ] Miscellaneous, %/

P B T

A Hello World £ ) Printf 475 Z 3T B S 5L,

5-29 it &5 1 General &5

&

r)i% “Use newlib-nano” .

Fr AANEL 2% “Use

nano printf” .

o AL NMAM “Apply” %4

AR N E RSO G RBHOM KA, REURBHRE I, AR sl e A2 A i sl A

B prR 2 3%

float with
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@ Properties for myProj m| X
type filter text Settings LA
Resource
Builders
« C/C++ Build Configuration: Debug [Active ] ~ | Manage Configurations...
Build Variable
Environment - - . . . . . 7 5 g
Logging % Tool Settings ® Toolchains B Devices 0 Container Settings # Build Steps Build Artifact & Binary Parsers @ Error Parsers
Settings = Target Processor Linker flags (-Xlinker [option]) £
Tool Chain Ec 2 Optimization
C/C++ General ¢ Warnings
Linux Tools Path ¢ Debugging
MCU v ® GNU RISC-V Cross Assembler
Project Natures 2 Preprocessor
Project Referenc 2 Includes
Run/Debug Sett @& Warnings
Task Repository (2 Miscellaneous
Tas_k Tags v ® GNU RISC-V Cross C Compiler Other objects )
Validation (2 Preprocessor
WikiText @ Includes
(2 Optimization
& Warnings
& Miscellaneous
v & GNU RISC-V Cross C Linker
(2 General
Libraries
v ® GNU RISC-V Cross Create Flash Image | Generate map ‘”!B{BuiIdArt\'fa(tFi\eBaseName}.map”
& General [ Cross reference (-Xlinker --cref)
v ® GNU RISC-V Cross Create Listing [ Print link map (-Xlinker --print-map)
& General [v] Use newlib-nano (Wspetsznano.specs)l
v ® GNURISC-V Cross Print Size L] Use float with nano printf (-u _printf float)
& General [JUse float with nano scanf (-u _scanf_float)
[[] Do not use syscalls (--specs=nosys.specs)
[]Verbose (-v)
Other linker flags ‘
= = Restore Defaults Apply

5-30 Al B 45341 Miscellaneous &1

5.3.4. L E T H 8 &BEMm 4
N T RE IEHA 4 3 nuclei_sdk SO A BRSO, FEEILRR Q0T AP IRECE O H A R A
(R
B P 5-20 Fi7s, 1E Project Explorer #4Hi% 4 hello_world Wi H, s RbrfAH, £FF
“Properties”
B EEEME AT, BIF C/C++ Build 325, Hifi “Setting” , 7E4 M Tool Settings
Hr it T E .
B 0 5-31 s, 37 GNU RISC-V Cross C Assembler i Includes, %[ &b frnfic &
BE A, BRIT .

ARSCAE PR A BRI SR B T, REERBHCR e P al, APHER. S HI sl A SO 2 2 sih o N . T 52
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® ¥ Include paths % H .3 N5 4
® B AIE st “Workspace” , i Folder selection % .
® {f Folder selection % 173 #:35 H 1Y nuclei_sdk H % K] NMSIS>Core>Include
A

® T{EATMEATd “Apply” 5EHACE -

B R R, KIKESIN nuclei_sdk H 3% T
SoC>hbird>Board>hbird_eval>Include, SoC>hbird>Common>Include Fl
SoC>hbird>Common>Source>Stubs A N EIA, FERAFFER AN GNU

RISC-V Cross C Compiler ] Includes 1= H % B & 8 15. WE TG AIE 5-32
FrR.

(5]
type filter text Settings . o
Resource
Builders
« C/C++ Build Configuration: Debug [ Active ] ~  Manage Configurations...
Build Variable
E:;"";’:'“‘“”l ® Tool Settings = Toolchains M Devices @ Container Settings # Build Steps ® Build Artifact & Binary Parsers @ Error Parsers
gging
Settings| @  Target Processor Include paths (-1} o[}
Tool Chain Ec & Optimization
C/C++ General ® Warnings
Linux Tools Path & Debugging @
MCu

Project Natures
Project Referenc
Run/Debug Set!

Select one or more Workspace Folders

v &2 helloworld

settings
Task Repository @ Miscellaneous ;e HE;GH
Task Tags « ® GNU RISC-V Cross C Compiler M
Validation (= Preprocessor Include system paths (-isystem) | o & NMSIS (4
WikiText  Includes .
v & Core
@ (5]
> SoC
Directory:
o o ' '
Cancel File system... =~ | 1
T = oenerar T
~ ® GNU RISC-V Cross Print Size
@ General
Q
2 [ ok | Cancel
0
2 > Restare Defaults Apply
7 Apply and Close Cancel

5-31 % & GNU RISC-V Cross C Assembler i) Includes £ H 15 %1%
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@ Properties for myProj O X
type filter text Settings vEYo
Resource
Builders
v C/C++ Build Configuration: |Debug [ Active ] ~ | Manage Configurations...
Build Variabl
Environment © - " . " . . . - .
Logging ® Tool Settings ® Toolchains B Devices O Container Settings # Build Steps " Build Artifact & Binary Parsers @ Error Parsers
Settings 2 Target Processor Include paths (-1) 28 85 &
Tool Chain Ec & Optimization
C/C++ General & Warnings "${workspace_loc:/${ProjName}/nuclei_sdk/SoC/hbird/Board/hbird_eval/Include}
Linux Tools Path 2 Debugging "${workspace_loc:/${ProjName}/nuclei_sdk/SoC/hbird/Common/Include}”
MCU « ® GNU RISC-V Cross Assembler *${workspace_loc:/${ProjName}/nuclei_sdk/SoC/hbird/Common/Source/Stubs}”
Project Natures (2 Preprocessor
Project Referenc
Run/Debug Sett & Warnings
Task Repository & Miscellaneous < >
Task Tags ~ & GNU RISC-V Cross C Compiler -
Validation = Preprocessor Include system paths (-isystem) L=
WikiText
& Optimization
¢ Warnings
¢ Miscellaneous
v ® GNU RISC-V Cross C Linker
¢ General
¢ Libraries
& Miscellaneous
~ ® GNU RISC-V Cross Create Flash Image Include files (-include) )
& General
~ ® GNU RISC-V Cross Create Listing
¢ General
v ® GNU RISC-V Cross Print Size
¢ General
< > Restore Defaults Apply

K 5-32 #% & GNU RISC-V Cross C Compiler 7 Includes # H & %42

5.4. ETF A Makefile A2 TiH

AT A A {8 ] E. 4 ) Makefile £ Nuclei Studio IDE 1] —Mifi fif Makefile ] Hello
World 3l H . JF & #~ Nuclei FPGA Evaluation Board, W% A N307. it F#k Nuclei SDK,
Github #%#%°4: https://github.com/Nuclei-Software/nuclei-sdk. %777k T I H 2 4b, &
T TR E S FEmA S, XL helloworld A, FEAPIRIT.

5.4.1. FEIHEM B

Ak “File—> New —> Makefile Project with Existing Code” . I 5-33 it

N

WE 5-34 Fias, 7EEbR 1 N T4, X BT 4 N nuclei-sdk. 78K Fx 2 4% N\ SDK
(IS iRig 2. fEEFR 3 4bikE “RISC-V Cross GCC” . HidiEbr 4 52U &g .
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@ CPDE - NucleiStudio

fFilcJedit_Source Refoctor Mavigate Search Project Run RV-Tools Window Help

Alt+Shift+N >f~  Makefile Project with Exis

Open Flle.
2 Open Projects from File System...
Recent Files

Close

& Ref
Convert line Delimiters To
Print.
Import
& Bxport.

Properties

Switch Workspace
Restart
Exit

GripvOThrArinG g i -

TC/Co+ Projec
1 Project...

» E Comvertto a C/C++ Autotools Project

© Comverttoa C/C++ Project (Adds C/C+ + Nature)

CUEWE g source Folder

CUlSHIeW o3 Folder
Cirlss € Source File
W Header File
Cirlsshiftes 0 File from Template
& Class
= Task
[y T Example.
F5 I Other CirleN
>
Ctrle P
Alt+Enter

3

! DConsole T Propert
Mo consoles 1o display at this time.

5-33 st T Makefile 19 TR

- =] *

Quick Access| | = | &
© & Outline ps

An outline is not available.

@ New Project

Import Existing Code

Create a new Makefile project from existing code in that same directory

Project Name Q

Inucleifsdk I

Existing Code Location (2]

I CAUsers\24954\Desktop\nuclei-sdk

‘ Browse...l

Languages
C[v]C++

Toolchain for Indexer Settings

<none>
Cross GCC
Autotools Toglchain 6

NU A
RISC-V Cross GCC

Show only available toolchains that support this platform

Y

W’

°

Cancel

K 5-34 BE TREED

AR N E RSO G RBHOM KA, REURBHRE I, AR sl e A2 A i sl A
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5.4.2. %8 Makefile #42#1 Build 2R

HirH T TR, 1&FF “Properties” T E UM, WK 5-35, E#HF “C/C++ Build” ,
7t “Build Location” #Hi&# “Workspace” . 7E5H FIFE ik “application —> baremetal
—> helloworld” fiifi “OK” Ffidi “Apply” {#4F.

type flter text e T " Select a folder from workspace:
Resource
Builders ~ & nuclei-sdk A
C/C++ Build] @ Configuration: Default [Active ] | Manage Configurations... & .
C/C++ General & .setti.ngs.
Li Tools Path . . ~ = application
inux Tools Pa El Builder Settings @ Behavior « Refresh Policy « & baremetal

MCU

Project Natures Builder :b benchmark
Project Referenc Builder type: External builder = demo_dsr_;
Run/Debug Setl Use default build command & demo_eclic
i = demo timer
Task Repository . . -
Task Tags Build command: ${(rossimake} Variables... vl hellow_'orld 9
Validation Makefile generation @ main.c
WikiText . . ; ] & Makefile
[] Generate Makefiles automatically Expand Env. Variable Refs in Makefiles i
= freertos
Build location & rtthread
Build directory: |$|w0rk5pa(ejo(:]nudeifsdk/app\\'(at\'on/baremeta\/he\\Dwor\d} ‘ & ucosii

= board-labs

File system...| Variables... = Build
2] = doc
= NMSIS .

6 ——

< > Restore Defaults I Apply I o
@ Apply and Close Cancel @ Cancel

5-35 At & Makefile 4%

UK 5-36, f£ “C/C++ Build” #i%&# “Behavior” £ H, #iffa)i% “Build (Incremental
Build) ” #&IiJH4 A “all CORE=n307 DOWNLOAD=ilm” . " “CORE” & IUARH 5 b 1 Py
%A, X HLLL n3oy A, “DOWNLOAD” MET A MBI R F#E, HAIES% 5.1
i, XHEPLilm A . K oHIFEE ) HummingBird Evaluation Board, FiPA SoC i1 Board
HA LB, oAl AT & H, L RVSTAR M|, iEfEILAL BN “SOC=gd32vf103
BOARD=gd32vfi03v_rvstar” , F%H T RVSTAR ¥ % # FLASHXIP #iz{, 206

“DOWNLOAD” % &N “flashxip” , [F “CORE” 12N “n205” . 5EHG fiti “Apply”
RAF B
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&) Properties for nuclei-sdk | X
type filter text C/C++ Build e

Resource

Builders

C/C++ Build] @ Configuration: Default [ Active] ~ | Manage Configurations...

C/C++ General (2]

Linux Tools Path = n

I\‘/Ir:iuL)J( oolsta EEl Builder Setting““ Refresh Policy

Project Natures Build settings

Project Referenc Stop on first build error []Enable parallel build

Run/Debug Set Use optimal jobs (8)

Task Repository Use parallel jobs: 8 =

Task Tags Use unlimited jobs

Va-\ifjation Workbench Build Behavior

WikiText Workbench build type: Make build target:
[1Build on resource save (Auto build) all Variables...
Note: See Worki)ench automatic build preference

OI Build (Incremental build) ‘a\l CORE=n307 DOWNLOAD=ilm ‘ Variables... I
Clean ‘(Iean ‘ Variables...
(4]
< > Restore Defaults I Apply I
@ Apply and Close Cancel

5-36 AC & Build L

e Lk RS, TOT T AR E T, WK 5-36, ZEIPECE, st “Apply” fRIF1E

e

AR N E RSO G RBHOM KA, REURBHRE I, AR sl e A2 A i sl A
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| Settings <

Canfiguration: Default [ Active ] ¥ Manage Configurations...
& Toolchains Binary Parsers @ Error Parsers

Name: RISC-V Nuclei GCC (riscv-nuclei-elf-gcc) |
Architecture: | RISC-V v ‘

Prefix: [riscv-nuclei-eli-

Suffic [

Ccompiler:  [gee

C++ compiler: |g++

Warning: these definitions do not affect the build and are for the benefit of the inde

1
|Tu0\:hain path: [${eclipse_homej\toclchain\geeibin |
fio shang it uss the alobal or workspace preferences pages or the argicit proper

IBuiId tocls path: [${eclipse_homel\taclchain\build-tacls\bin |

to change it use the global or workspace preferences pages or the project proper

Restore Defaults Apply
@ Apply and Close]|| cancel

5-37 BoE LHEEKS

RPEIEAT UL R N A S B % 5. 6 1.

6. 4miEIH
6.1. Nuclei SDK THE&%ETE

£ Nuclei Studio # 7] LLifiid Nuclei SDK T2 & T H—# & %@ T Nuclei SDK Project
Wizard 68 1) TR 4 e Rk . A TR B XS Nuclei SDK, HBird SDK, Nuclei
SoC IP SDK, A FLERFINERFIE MET Makefile QI2MTE, SE R BTQIR%E
FHIBE . A R

Bk FEEM TR, 2 EmE 6-1 #TJF RV-Tools>SDK Configuration Tools, ] LL$T

AN PITIR A BB ER BT, RSP R TIRA, AMSAERR . S Sl e A SO 2 A iR sl A T 58
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S IR I T3 E . ] LRGBS TS, R 6-2, A TR TERE THAE
bro B AR EANE TG, B R ctrl+6. AL HEEN N TG, WK 6-3, A
T AEESE R, %% SDK Configuration Tools. MK 6-4 N TFEWE T HME, SEIE4NTRE
o

B projectName N YAFTIEF I TS .

B Core NY4uI LFEXTMWNZ. BT L EMRYE ARCH A1 ABI 2EI0 S HE H X NI A AZ, 1
ANE N A% AT e A EN ) ARCH AT ABI &0, Frblii s ErlfesA iz, H% ARCH
55 ABI N IERAIGEIED O] o eade 0 A 5 (58 B 1) e Py A% 25 3004 FH

® JU/M2)3%ETE: Bitmanipulation Extension(RVB), Cryptography Extension(RVK), Packed
SIMD/DSP Extension, Vector Extension(RVV) T #ex N 15 845 (B/K/P/V)

B ARCH X4 HT TFER) arch 3%, #R¥E Core A1)k H sh4H & -
B ABI X 24 A7 LR abi JET0.

B Tuning R A[F A A FZRRALI gee LT, 1E#E Core & H 3k IEH K Tuning %
I, AEWH DR,

B Code Model £ X RV32 AbBEES, HENERA Medium Low, T4 RV6yq AbEE LS H zhik
#%5 Medium High, 13 Core LLJG< H3NE#HFA &K Code Model, H 1 RV64 Ab3H #%
DAZ5E ) Medium High.

B  Download X} W 47 TFER) FEAER, AT LY B BEAE R FEAER, HAiY Nuclei
FPGA 15T R AR SZ et F 38 , RVSTAR {4 FLASHXIP # =, H1]#:3 flash
R 2%/ E X VECTOR_TABLE. REMAPPED %%, At s A2 52 S A%

B Select C Runtime Library %} W ) F AR C FE. & LREQIZERIE, R eI R TR
HI 72 Newlib, X B H g83E17 newlib kAT, an iR 6@ 1 T2 H 12 Nuclei C
Runtime Library(libnert), ix B X 883847 libnert A Y4

B Optimization Level 3 4 %I AL 2 .
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B Extra Common Flags X N )& 8140 i B 4 eI 0. AT LAV DERT A M ) 388 FH 2 208 10
B Extra C Flags X R 2#4M) C ik Il. v LA INZRAM C g PR il .

B Extra C++ Flags X N 22N C++9nidi . A A INALSME C++5n 1L 1

B Extra ASM Flags i B )2 B RV g 2 e T . AT LS DA A/ )91 20 20 1126 100

B Extra Link Flags % M2 FUMO R i RILEI O 224 BN IRIUT H 75 2258 hn gy
PRI, AT LAAE G 1 1 T Sk 45 R A A B — A 28 A% 7 157 P 1 N 2 126 38 0

PRI 7 EAE g LA B RED, X BRI UE SN ED -0 RAGE BT HAT ST RN il
save —HME R IFILEIL, save PLJE —E2EE clean project, 25U 6-5, ftiiEUs I TIEST
TFAHERR, & “Clean Project” JEHE— F TR, Fi Al 1 B4R R AT 58 A& i g BF 1 01 5
Wi LA

@ CPDE - NucleiStudio - a X
File Edit Source Refactor Navigate Search Project Run| RV-Tools |Window_Help
4] 0| ™| ORun & hello_world_debug_¢ & SDKC n Tools b o cvovr bvovhvavyse oy vl v Quick Access| =]
& Project Explorer 2 :m:p‘ i (TTIT’;HD'“ pege & Outline

NMSIS Documentation An outline is not available.

hello_world_debug_openocd launch

£ Problems < Tasks © Console * [lProperties #Terminal
GNU MCU Eclipse Packs console
Completed in 3ms.

6-1 FTIHE e BRI I 1
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@ CPDE - NucleiStudio

- o X
File Edit Source Refactor Navigate Search Project Run RV-Tools Window Help
&][0][m] 0Run < @1 _helloworld_debug_~ ¢ » CEX SR DB - A AL TE LR [Quick Access| | = | 1E8
& Project Explorer = eBlw =1 £ Outline ssk List ® Build Tar... % Docur
~ &1 helloworld -

& Binaries An outline is not available.

# Includes

& application

& Debug

& nuclel sdk
1_helloworld_debug_openocd launch

roblems asks @ Console ¢ s & Termirn
CDT Build Console [1_helloworld]

T L]

1 helloworld

Kl 6-2 TIHE S PRI I o 2

@ CPDE - NucleiStudio

- s} *
File Edit Source Refactor Navigate Search Project Run RV-Tools Window Help

4|0 [=| ORun ~ @1 _helloworld_debug_~ (=8 LAA SN R A-IRIEAL N AR CE N-R AL RAOUE S A ol T 4l rhHrGera - |Quick Access| ;| = | &
& Project Explorer & a%le =1
v = 1_helloworld

& Binaries New b4 An outline is not available.

E Qutline Buil r.. T Docun

# Includes Go Into

& application
& Debug

& nuclel sdk

1_helloworld_debi © Copy cil+C

Paste Ctrl+V

% Delete Delete

Remove from Context Chrl+Alt+Shift+Down

Source >

Open in New Window
Show in Local Terminal >

Move.
Rename. F2
= Import.
i Export..
Build Project
Clean Praject
Refresh F5
Close Project
Close Unrelated Project
Bulld Targets. > ; F T I ELIEL
Index »
Build Configurations >

Profiling Tools >

Validate

Run As >

Debug As >

Profile As >

Restore from Local History...

SDK Configuration Tools Ctrl+6
TR 70T + Code Analyes

Team >

Compare With »

#0

qe

Configure >

Saurce >

Properties Alt+Enter

1 helloworld

K 6-3 FTIHE e e I & 3
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@ Nuclei SDK Project Configuration - O X

projectName : HelloW
Configuration: |Debug ™

Core: N205 ~
O Bitmanipulation Extension(RVE
[] Cryptography Extension(RVK)
[[] packed SIMD/DSP Extension(R
[]vector Extension (RVV)
ARCH : |rv32imac |

ABI: |ilp32 |

Tuning : |Toolchain default ~

Code model: |Medium Any (-mcmodel=me ~

Download : |ILM %

Select C Runtime Library : nuclei ¢ runtime library, optir

Optimization Level : |Optimize size(-Os) ~

Extra Common Flags

|
Extra C Flags : |
Extra C++ Flags : |

Extra ASM Flags : |—x assembler-with-cpp

Extra Link Flags : | -Wl,--check-sections

Save Cancel

SDK Configuration Tools:1.0.0.1

6-4 — B U LI
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@11 _helloworld_debug

New
Go Into
Open in New Window

Show in Local Terminal

‘B Copy
ste

ctor Navigate Search Project Run RV-Tools Window Help
Br{va

Restore from Local History..
@ SDK Configuration Tools
% Run C/C++ Code Analysis
Team
Compare With
Configure
Source

Properties

1 helloworld

Ctri+6

Alt+Enter

&~

2w

6-5 JHEL LREF BB 4 1 A2

X B ff) SDK Configuration Tool V]#: 425} Debug Configuration &L 2 zh, [Fitin
R T Core LG, XF M 1EIAR B (OpenOCD/QEMU /JLink) t 75 2 F s 1& M4

TEER AR WIREY e TR 32 A48 64 7, FFEAT B E W, mE 7-6, 1B
“command” H “set arch riscv:rv32” N “set arch riscv:rv64” , M 64 H7 ) H[E 32 7N Y

& B0 B S BT B EUE
6.2. 7E Nuclei Studio #%%# Hello World Ti B

7E Nuclei Studio 2w PERUTT .

BN RN, EUEIEEE . WK 6-6 fian, 1t Project Explorer 42 H1ik A

hello_world Wi H, B brAH, 13 “Clean Project” .

B I 6-7 FiR, WS T, TFR O E AT R R, TR
W 6-7 TR, AERS T BIA RATAT SCPERORIS AR AN, (34T text B2, data BUAI bss
Bt LUK/ M-F RIS S0 . ) Makefile 72 BTy TR d B e 47 50

ARSCAE PR A BRI SR B T, REERBHECER S T, AHERE. SR s i A S 2 il oy WA

T 63



R
NUCLEI

Hrpi% % “Build Project” #HT41%.

8 CPDE - NucleiStudio = [l X
File Edit Source Refactor Navigate Search Project Run RV-Tools Window Help

&][c][=] ORun < @ hello_world_debug o+ | i v Bri v L BTN LW B ETErEvETIETOTR AT AT R TR R [Quick Access||| = | &
& Project Explarer b = 1 Outline E G
15 helln werird w
New > An outline is not available.

Go Into
Open in New Windaw
Show in Local Terminal >
Copy CulsC
Paste CtilsV
% Delete Delete
ve from Context Ctrl+Alt+ Shift+ Down

@l
&1
I

Ren
Source >
Move,

Rename... F2

Import..
4 Export.

Build Project

I Clean Project |
Refresn 5
Close Project

Close Unrelated Project

Build Targets >
Index >
Build Configurations >
Profiling Toals >
Validate
© Run As >
% Debug As >
Profile As b
Restore from Local History..
© SDK Configuration Tools ctri+6
# Run C/C++ Code Analysis
Team B lems © Console ries & A O
Compare With > || GNUMCU Eclipse Packs console
Configure ,| | Complated in 3ms. ~
g Mo installed packages.
Source > | completed in 3ms.
Properties Alt+Enter 2020-08-06 11:13:08
Extracting devices & boards...
Ho installed packages.
Completed in 2ms.
% hello world &

6-6 X hello_world i H #.ii 45 # £ % “Clean Project”
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@ CPDE - NucleiStudio

- 9 x
file fdit Source Refactor Navigate Search Project Run RV-Tools Window Help
[4]/C/[=] ORun I hello world_debug o (= BT A BTN LW R AT E T v T HETOTRTAISE ST LR R L [Quick Acce
& Project Explorer © e 1 % Outline =
An outline is not available.
nuclei sdk
hello_world_debug_openocel launch
© Consale o a J Wir@rov
CDT Build Console [hella_world]
OVQKANG: GNU KiSL- T size .
riscv-nuclei-elf-size --format=berkeley “hello_world.elf"

o tet dta bss dec hex filename
7732 112 2290 10134 2796 hello_world.elf
Finished building: hello_world.siz

11:40:18 Build Finished. @ errors, @ warnings. (took 3s.655ms)

<
+% hello world

K 6-7 sy 1 EAsxt hello_world I H #E17T4m %
O PN Ja W LLE BN S Debug SO, ikl 6-8, A SCHHEMANT:
B hello_world.elf &4 B AT $147 3C1F
B hello_world.hex &4 ) Hex 3 ff.
B hello_world.Ist 242 B list SO, 7T AR 21 B 4 A ] 5 1 AL 20 A5 12

B hello_world.map »&4 B map X, AT LATEGHHE 3142 B rARS 70 A1 175 10 o

AN PITIR A BB ER BT, RSP R TIRA, AMSAERR . S Sl e A SO 2 A iR sl A T 65
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@ CPDE - hello_world/Debug/hello_world st - NucleiStudio o X
File Edit Source Refactor Navigate Search Project Run RV-Tools Window Help
&|[0][=] ORun @ hello_world_debug_o o~ LRSS RA-IVEG SRR AR XA S R A RN L TR S TR R TR 200 4 > Juick Access|

Project Explorer hello_world.st **  hello world.map Outline
223 .weak eclic_irq5e_handler

.globl vector_base
or_base:

226 vector_base:
227#if defined(DOWNLOAD_MODE) && (DOWNLOAD_MODE != DOWNLOAD_MODE_FLASH)

j _start /* @: Reserved, Jump to _start when reset for ILM/FlashXIP mode.*/
80000000:  1980006¢ j 80000198 <_start>
80000004: 0080 unimp
80000006: 0000 unimp
80000008: 0532 slli  ae,a8,8xc
8000000a: 8000 x8000
8000000c: 0080 unimp
8000000e: 0020 unimp
80000010: 0532 s1li  20,20,0xc
80000012: 8000 x8000
- 80000020: 8532 s1li  20,28,0xc
242 80000022: 8000 ©x8000
hello_world_debug_openocd.launch 241 80000024: 0000 uninp
80000026: 0000 unimp
80000028: 0532 s11i  20,30,exc
8000002a: 8080 0x8000
8000002c: 0000 unimp
8000002e: 0000 unimp

O Console
CDT Build Console [hello_world]

Writable Insert 1:1

Kl 6-8 &A% A ot

7. ARz 1TIH
7.1, fFHESEERE S OpenOCD HRIE1TH H
7.1.1. 23 SRR R IR

Nuclei Studio | 2021.02 fii A #2 openocd 523 windows % BRI AE, i FH IR A K LA F
windows P85 H 2 ATk T, Linux PRI RRECE RSN . KT EARA I P FHIE LUF 7
ZHEIREF

7.1.1.17 Windows &Zi 235 IR7)

PRGNS, (T DGR T 308) FPGA JSUFF RHUEAT. ¥4 BEIF Kb 15 £ 4 PO
AT, BT

BRI AR A Sl AN AL PC 1 USB 42110, 5y — i 5 5 AP AMOERE . T ik

ARSCAE PR A BRI SR B T, REERBHCR e P al, APHER. S HI sl A SO 2 2 sih o N . T 66
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e — S e SR A, N T8 /R =ML PC () Windows £ 4t % 10 Hiig 5 8 R 25 11
USB, FEZHEIKE), XHuE 1-2 s NucleiStudioIDE O, 71 ) HBird-
Driver.exe B[l 7] 52 A b BX Bl 1) 2225 o

B TS IEREE RS T COREADT RS ) UART #240% USB” 1yZhae, RutiniR
e S IR A AL PC R T (HIXBh 2D A AR BEws 4 LRI oy — 4
COM Hi .

® nE 7-1 Fian, fEEMNL PC WA EHFHA“E: 1 (COM Fl LPT) £ H”Ha] PA#
#%]iZ COM [ 15 (B41 COM11) »

® b DR e SR i AT IR FoRt 78 2 R AU R RIS AT RE /7 (1) printf fa tH Bos 2 H .

A pEgEs - | X
XHHF)  IREA)  EENV)  EBEIH)
& T Hm &

v M DESKTOP-V8C6817 "
=@ IDE ATA/ATAP| $2:51|28
By 2eigs
[ o
- TERIKTHES
G iR
= FTEDRAT
P =it

v @ %0 (COM #0 LPT;
|ﬁ USB Serial Port (COM‘H)I
¥ =F
O e,
o Ysinss
==ty
0 w7
i AEBNRE
1 wprgs
F wprae
i AR, U
0 stFnEfissHeE
§ ERRTasiEE
§ ERSTREIRE
P RRIERRS
in RS
I BREEE
W E=dmes A EniH

7-1 R EHGE T AN COM 15

R Al i TR T, WEER S 1 Windows 1IE#IRM,
56 P b o B 9 215 Hh B i IE T 224% 1 HBird-Driver.exe HIIKZ), HBE0E7E & 25 5 BRAS 20 ) ]
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COM & M5,

7.1.1.27F Linux 4B

7F Linux 855~ 225K 0T

1: ERITAHRE Linux F1, ik USB # Linux 5 k. W AR EUNL, K
BRI RS T RSB

2: fEFEHI G P Isusb 82 EHEFE, SHENITEMERWIT:

Bus 001 Device 010: ID 0403:6010 Future Technology Devices International, Ltd

FT2232xxxx

3: f&# 4 h#i N\ sudo vi /etc/udev/rules.d/99-openocd.rules 5437 I 99-
openocd.rules 3CAF, HIAMITFAZ, (RAFIBH

SUBSYSTEM=="usb", ATTR{idVendor}=="0403",
ATTR{idProduct}=="6010", MODE="664", GROUP="plugdev"
SUBSYSTEM=="tty", ATTRS{idVendor}=="0403",
ATTRS{idProduct}=="6010", MODE="664", GROUP="plugdev"
4: Wit el as FE B BT %L 2] Linux R4 .

5: il Is /dev/ttyUSB*fi & &% ttyUSB {5 5, ZE MW : /dev/ttyUSBo
/dev/ttyUSB1

7-2,

6: fiiH 1s -1 /dev/ttyUSB1 s 2 EE 7 AHE S, SHHH W T : crw-rw-r-- 1 root plugdev

188, 1 Nov 28 12:53 /dev/ttyUSB1

AT LUE 2] ttyUSB1 &M plugdev 4, 421 REATEN B N2 plugdev A CA[F]
IEEATRE L TN, TERYE SLPRE B NSD o i whoami & &F MATH %4, A

¥ HAC T N < your_user_name >

ARSCAE PR A BRI SR B T, REERBHECER S T, AHERE. SR s i A S 2 il oy WA
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B 7. {#/] sudo usermod -a -G plugdev <your_user_name> x4 H .7 ik plugdev
H. IMALUGE—E B E Sl EFHFEHEERS.

B 8: HXHAMETH L )BT plugdev 4., 1#H groups #r4, " LAEFHTEE Bbg
plugdev B Tk 2410 F P 3 IN A plugdev . Wi EA AT AR E H

7-2 TPRBOES ML

7.1.2. 5283 & Debug Configuration
T Nuclei Studio 1 it & Debug Configuration N2 K5I .
B 7-3 Pon, EREAETERE “Run—>Debug Configurations” .

B K 7-4 Pow, EFRERE DT, A S TR RENS, GRS “GDB
OpenOCD Debugging” , &% “New” , ¥ AT H #re  — N H
“hello_world_demo Debug” , #IE 7-5 ffiin. #ifk “Project” &4 ni 75 Z A T
£, “C/C++ Application” Hik$ [ 1IEAIT 75 2831 ELF X

B E 7-6 Fian, iEBEAIRIIE “hello_world_demo Debug” ] Debugger 32 5., 7&
Config options = H HIEA-f
"nuclei_sdk/SoC/demosoc/Board/nuclei_fpga_eval/openocd_demosoc.cfg", VAR
OpenOCD 1 F IEf B BC B SO F o 3 Ll B A
(nuclei_sdk/SoC/demosoc/Board/nuclei_fpga_eval/openocd_demosoc.cfg) R 3 52 bx

AR N E RSO G RBHOM KA, REURBHRE I, AR sl e A2 A i sl A i 69
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T2 openocd IC & CAFEE AT E . BlAn: W FA# F makefile 7 RSN TR, Bouk
AE IR 25 N -f “SoC/demosoc/Board/nuclei_fpga_eval/openocd_demosoc.cfg”.

U RGN A% A RISC-V 32 A7 N#%, E#i{# Commands W& fLE set arch riscv:rv32
WERAH NN 64 61, NIRE N set arch riscv:rvé4

B K 7-7 fon, %R ITH “hello_world_demo Debug” (] Startup £ 5., Hifx
“Debug in RAM” , “Pre-run/Restart reset” , “Set Breakpoint at Main”
“Continue” #4)i%.

B WK 7-7, e SEA T “Apply” RAFIRE

@ CPDE - NucleiStudio - [« ®
File Edit Source Refactor Navigate Search Project Rum RV-Tools Window Help
&|[0][m] ©Run @1_helloworld debug_ © Run Cri+Fl I pigv v v @ ritvOvT Qv AvidG & v rHreYD Quick Access||| = | &
- = Debug F11 - N
Project Explarer * - @ Profile £ Outline

Profile History
Profile As
Profile Configurations...

An outline is not available.

Run History >
1_helloworld_debug openocd Jaunch N
| Run Configurations... I
Debug History >
% Debug As

Debug Configurations.

Breakpoint Types

Toggle Methad Breakpoint
= Skip All Breakpoints Ctri+Alt+8
Remove All Breakpaints

% External Tools

O Console . AMBvov=a
DT Build Console [1_helloworld]

21:37:11 **** Clean-only build of configuration Debug for project 1_helloworld ****

make clean

rm -rf ./nuclei_sdk/SoC/hbird/Common/Source/Stubs/close.o ./nuclei_sdk/SoC/hbird/Common/Source/Stubs/fstat.o ./nuclei_sdk/SoC/hbird/Common/Source/Stubs/gettimeofday.o ./nuclei_sdk/SoC/hbi

21:37:11 Build Finished. @ errors, © warnings. (took 171ms)

1 helloworld

K 7-3 #ii “Run Configuration” #HT F#
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@ Run Configurations | X
Create, manage, and run configurations @
(SR X[ B3~ Configure launch settings from this dialog:
type filter text | - Press the "New Configuration’ button to create a configuration of the selected type.
¢ Build Docker Image + _ Press the ‘New Prototype’ button to create..onfiguration prototype of the selected type.
] C/C++ Application , , .
1 C/C++ Container Lau | ™ Press the ‘Export’ button to export the selected configurations.
€1 C/C++ Remote Appl | [ - Press the 'Duplicate’ button to copy the selected configuration.
€0 C/C++ Unit % - Press the 'Delete’ button to remove the selected configuration.
© Docker Compose
P =D shambillombubtanda.configure filtering options.
v EIGDB OpenOCD Def ™ New Configuration . o
& hello_world deb % ew Prototype uration by selecting it.
€1 GDB PyOCD Debur .5 Export... nd then se..nk Prototype’ menu item to link a prototype.
E1GDB QEMU DEbeg Duplicate nd then se... Prototype’ menu item to unlink a prototype.
1 GDB SEGGER J-Linl i Delete
nd then se..s" menu item to reset with prototype values.
@ Launch Group i Link Prototype... * e
# Launch Group (Dey  ynjink Prototype
Launch over Serial | Racet with Prototype Values tings from the 'Perspectives’ preference page.
& Run Docker Image
< >
Filter matched 15 of 15 iter
@ Run Close
7-4 7 ) GDB OpenOCD Debugging
@ Run Configurations O x
Create, manage, and run configurations @
ER@x% Y Name: hello world_debug_openocd
type filter text || Main . Debugger|  Startup| + Source |l Comman % SVD Path
Build Docker Image
[© C/C++ Application
[ C/C++ Container Launcher Browse..
[ C/C++ Remote Application C/C++ Application:
© Docker Compose = =
« £ GDB OpenOCD Debugging Variables..  Search Project... Browse...
&l hello_world_debug_openocd Build (if required) before launching
E1GDB PyOCD Debugging Build Configuration: Select Automatically v
[ GDB QEMU Debugging
[ GDB SEGGER J-Link Debugging ) Enable auto build () Disable auto build
& Launch Group (®) Use workspace settings Configure Workspace Settings.
# Launch Group (Deprecated)
Launch over Serial
4 Run Docker Image
Filter matched 15 of 18 items Revert Apply

7-5 GDB OpenOCD Debugging #:H T hello_world 5ii H Debug
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€ Run Configurations

Create, and run

FPRaEXIB® -
type filter text
% Build Docker Image

Name: ‘ hello_world_debug_openocd
© Main | $ Debugger > Startup| & Source| = Common % SVD Path

X

TC/C o+ Applicati OpenOCD Setup A
e appcation ] Start OpenOCD locall
& C/C++ Container Launcher P Y -
1 C/C++ Remote Application Executable path: | ${openocd_path}/${openocd_executable} | Browse... Variables..
€1 C/C++ Unit Actual executable: C:\Users\24954\Desktop\NucleiStudio | DE}DZGOH\Nu(IeiStudiuilDEﬁZﬂZUDB\Nu(leiSIudin\\lDl
© Docker Compose . (to change it use the global or workspace preferences pages or the project properties page)
~ [ GDB OpenOCD Debugging GDB port: 3333 |
= hello_world_debug_openocd .
¥ GDB PyOCD Debugging Telnet port: 4444
E1GDB QEMU Debugging Tel port: 6666
< GDB SEGGER J-Link Debugging| - config options: |-f "nuclei_sdk/SoC/hbird/Board/hbird_eval/openocd_hbird.cig”|
& Launch Group
# Launch Group (Deprecated)
Launch over Serial Allocate console for OpenOCD Allocate console for the telnet connection
@ Run Docker Image GDB Client Setup
Start GDB session
Executable name:  ${cross_prefixjgdb${cross suffix} Browse... Variables...
P! 9 A |
Actual executable: riscv-nuclei-elf-gdb |
Other options: |
Commands: set remotetimeout 250 A
set arch riscvrv32 "
Remote Target
Host name or IP address: localhost
Port number: 3333
["] Force thread list update on suspend v
< >
Filter matched 15 of 18 items L= LB
® =
] 3
7-6 i & hello_world_demo Debug 2% 1
@ Run Configurations =] ®
|
| Create, manage, and run configurations @
\
BRBNIER Name: hello_world_debug_openocd
type filter text I Main % Debugger » Startup - Source = Common = SVD Path
B:é'd f’:‘p‘:;{':;f Initialization Commands
/C++ Container Launche | LJnitial Reset. Type: ini
#1C/C++ Remote Applicatic
€ C/C++ Unit
© Docker Compose -
+ /GDB OpenOCD Debuggin| | £01e ARM semihosting
@ hello_world_debug_ops  Load Symbols and Executable
T GDB PyOCD Debugging | [+ Load symbols
 GDE QEMU Debugging (® Use project binary: hello_world.lf
I GDB SEGGER J-Link Debuc| () Use file: Workspace.. | File System
4 Launch Group .
& Launch Group (Deprecate,| >YMBels offset (hex):
Launch over Serial e
& Run Docker Image (®) Use project binary: hello world.elf
© Use file: Workspace..  File System._
Executable offset (hex):|
Runtime Options
Run/Restart Commands
Pre-run/Restart reset Type: halt|(always executed at Restart)|
[ set program counter at (hex):
/] Set breakpoint at: main
Continue
Restore defaults
< >
Filter matched 15 of 19 items Revert
@ e
s
K 7-7 ELE hello_world_demo Debug K245 2
> SN Mo shfl BN 2 R ~ YA K skl 4 - A FLEAE S Gt 52 > > N
ASCAF TR A B R B SR B , RGBT, AR, SR sl e A SO 2 ek . g 72
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7.1 3. FEREIT R LIRAREF
AR R AT, @ ZATIF 8 0 DMEUEE Printf o8 3037 HIE 2.
fi H Windows R Gt R L5500 7F -

B {TJT Nuclei Studio B ()5 HATERIEE, 1263 Window>Show View>Terminal, 41K
7-8 7R, midriwonas BRI e D E IR, K 7-9 fos, EHE HH1E Choose
terminal GZEFH M, B Serial Terminal) . “H 157 CGXHLPL COM11 A#D « “3
ke (E N 1152000 7 245, Hili “OK” %4,

8 CPDE - NucleiStudio = [l X
File Edit Source Refactor Navigate Search Project Run RV—IUUIsHeIp

%][G][=] ©Run @l hello_world_debug o b= New Window AR ECH AR RS Ad -0 ha Rel LT A4 -~ * D~ |Quick Access| | | B
& Project Explorer e S I Eritcy & ! & Outline

& hello world Appearance >

% Build Targets An outline is not available.

Perspective 5 & C/C++ Projects

@ Console Alt+Shift+Q, €
Navigation > m Documents
nuclei_sdk Preferences s e
hello_world_debug_openocd.launch € Mavigator
= Outline Alt+Shift+Q, O
@ Prablem Detalls
£ Problems Alt+Shift+0, X
& Project Explorer
O Properties
¥ Search Alt+Shift+Q, S

B Task List Alt+Shift+Q, K
Tasks
LLr_Terminal ] o

Other. Alt+Shift+Q, Q

G[~)

L Problems < Tasks ©Console ™ Properties &~ Terminal

7-8 j@iT Nuclei Studio FT7F & OB F I & 23
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@) Launch Terminal U X

Choose terminal: Serial Terminal ™
Settings
Serial port: [COM11 v
Baud rate: 115200 ™
Data size: 8 >
Parity: None ™
Stop bits: |1 >
Encoding:  Default (ISO-8859-1) &7

@ Cancel

7-9 WEHNZH
i/ Linux RGEFTF R DA T

B {77 Nuclei Studio H 7] Terminal ¥, %% Window>Show View>Terminal, #1F&
7-8 7R, i nas BRI s D E e . a1 7-10 7R, choose terminal 4%
Local Terminal, #iii OK ] Terminal %Ki, @k 7-11 fizs, %A\ “minicom
/dev/ttyUSB1 115200” #THFH 1, EITA7E Nuclei Studio H 2 F & LT EHIE E..

B Launch Terminal

Choose terminal: | Local Terminal -
Settings

Encoding: | UTF-8 M
® Cancel OK
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7-10 #TJF Terminal % i

& hbird (ubuntu) 2

Welcome to minicom 2.7

OPTIONS: I18n

Compiled on Mov 15 2018, 20:18:47.
Port /dew/ttyUSBl, 14:38:85

Press CTRL-A Z for help on special keys

CTRL-A Z for help | 115280 8N1 | NOR | Minicom 2.7 | WT182 | Offline | ttyUSB1

B 7-11#7F0

WERAR T 01 A e s AT T IR A Rk h #27, 7T LU A Nuclei Studio IDE #4711
tHT IDE 1217 T EHL PC ¥, MARTFIEAT THEEF KR b, X Fisdmcoy “7Egkiim” 5
H R .

iX H L 1_helloworld ], 1#H Nuclei Studio IDE %} Demosoc Ji % 7 & R 47 7E 2k 1 )

SIRIT

B fifR 6.2 1) Debug W E N LM, W LTI Debug W EETIHHIN. WK 7-12 fr
7~, 1E 1_helloworld T# 447, %+ “Debug As —>Debug Configuration” 7
Debug 5 & k45 BT 2 M B d.

B ERELCRG, £E 7-13 [T RAEE S Debug, )5 2 M Ebra A 00 du by, Hd
B AT 32E N R A O T 3R 3 E AT AR

ARSCAE PR A BRI SR B T, REERBHECER S T, AHERE. SR s i A S 2 il oy WA i 75
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€ CPDE - NudleiStudio - & x
File Edit Source Refactor Nevigate Search Project Run RV-Tools Window Help

%/ 0 = ORun ~ | T 1_helloworld debug -~ (=R4 BrA vy L@y RR | iR AT T T HETOTR YA YIS S x Quick Access| = | |Gl
& Project Explorer 7 E®ly “- 0o -o
+ 51 _helloworld

& Includes New > An outline is not available.
= application Golnto

# Outline ® B ar.. [

Open in New Window
Show in Local Terminal »
Copy ctrisC
Paste Ctrisv
® Delete Delete
Remove from Context Ctrl+Alt+Shift+ Down
Source »

Build Project

Clean Project

Refresh FS
Close Project

Close Unrelated Project

Build Targets >
Index ¥
Build Configurations »

T

31d of configuration Dsbug for project 1_helloworld *=**
::Z'“‘ﬂm" * lird/Common/Source/Stubs/close.o ./nucled_sdk/SoC/hbird/Common/Source/Stubs/fstat.o . /nuclei_sdk/SaC/hbird/Common/Source/Stubs/gettimeofday.o . /nucled_sdk/SoC/hbi
alidate

O Run As 3

o s 5] = 1¢/C++ Container Application
Frafle As % [ 2 Local C/C++ Application

Restore from Local History. Debug Configy

SDK Configuration Tools Ctrl+b

Run C/C+ + Code Analysis

Team >

Compare With >

a0

Configure »
Source »

Properties AltEnter

>
1 helloworld ¥

7-12 #ii “Debug Configuration” #:47 %

8 CPDE - NucleiStudio

- o x

ile Edit Source Refactor Navigate Search Project Run RV-Tools Window Help

S[E) = #0ebug 11_helloworld_debug_~ | [ = B T T - TR T G VS S P ST S QPP 2 o Guick Access i = |8
a®le =0 & Outl =7 % Docy

& Project Bxplc o o Outline iid Tar... % Docur

~ & 1_hellow

& Bina

An outline is not available.
& Includes

& application

& Debug

& nuclei_sdk
1_helloworld debug openocd launch

roblems & Tasks @ Console : s &Terminal = Disassemt
COT Build Console [hello world]

9 R - R

0 items selected

K 7-13 V)% Debug #ik
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B QU RERTD, WnE 7-14 Fos, IFEa B3R AR .

@ NucleiStudio_workspace

e 7-14 1) 1 SERERLE,

WK 7-14 ) 2 SR,

wE 7-14 1 3 ShREAME,

LA B 53

WK 7-14 1) 4 ShRiEAE,

WE 7-14 ) 5 SHRIENLE ,

e 7-14 1 6 SHrEALE,
2 HT A EUE

WE 7-14 1) 7 ShRyEMN &,

e 7-14 1) 8 SHhpiEA ERI N, X Hu] iR GDB #4615

- MucleiStudio IDE

XEIR A AL,

B T S N [ /Y e W VA

1847, IS ZOREE

FEACHD 0 22 M0t RV AT A2 1247 BB K A, BRI AT BL

3% BT LAY 2 R A AT T AR

e R H N AL B R AL B

RERERTARSENCE. K ERZE PCHF

X B AR AT LR H R AR

AT B

- helloworld/application/main.c - s} *
File Edit Source Refactor Navigate Search Project Run RV-Tools Window Help L [+]
& |[®][®] ©Debug ~ Ehelloworld_debug_of - B BTOTAY ™5 v u_q,, B~ v (5 0O a =
Debuq & Project Explorer B 170 @mainc Emaine  ©(gdbl1]proci42000] threadGroupli1Lgdbl1]proc42000] OSthread 1]) thread(1] frame{0] T ofeve %B wE &M AP % 7 D)k Registers §eln=1=n0o
Ehelloworld debug openocd [GDB OpenOCD Debugaingl 65 if (misa bits.b.p) { ~ zalrie il IName
% helloworld.elf s , misa_chars[index++] = 'P'; Name Type 1
v #Thread #1 (Suspended : Step) o S i int ©
[ f bits.b -
= main() at main.c95 0xB0000fde =l (:i:-:;;s[l:leﬁ“l R o rval uint32 t 6
= openocd.exe o } - ! or misa st t i pe
2 riscv-nuclei-elf-gdb 71 if fmlsa_tnts b.u) { 0
- R misa_chars[index++] = ft1
if (misa_bits.b.v) { e
misa_chars[index++] = 'V'; 3
) it
if (misa_bits.b.x) { its
78 misa_chars[indexs+] = 'X'; ith
79 ft7
g8 s0
1 misa_chars[index++] = "\@';
o fs1
83 printf("MISA: RVEs\r\n", misa_chars); fa0
84 } fal
_ss fa2
= ?nt main(void) fa3
88 sran d(_get . :yclet) | _get_rv_instret() | _RV_CSR_READ(CSR_MCYCLE)); ;”;'
8 nt32_t A
%8 rv_csr_t misa = w CSR_READ(CSR_MISA); fab
a1 < H (N >
5. pr)néf( vrf,; exXIx\r\n", misa); Name : misa ""‘EH: p; s0000¢4
T . = print_misa Details:1075089769 lex:@x880807dc
@ Current Position ol efaulc:Le7ssssnes Decimal: -2147479588
o a5 for (dnt i = @; i < 20; i ++) { mal: 1875885709 0ctal:@20000007734
ek printf("%d: Hello World From Nuclei RISC-V Processor!\rin”, i); .m [g)@giqglzd Binary:18808088680B0000¢
© Break Point — 7Y Biary: 1080800606101001¢ Default: fde <mair
98 O:ta'l to1c00s110455
929 return @;
168 }
101
102 v
o < > e

AR N E RSO G RBHOM KA, REURBHRE I, AR sl e A2 A i sl A

Breakpoint 3, main (} at ../application/main.c:92

MMMMMM

o, pref o |_,1|$[ suffix) (722)

92 printf("MISA: 8xX¥lx\rin”, misa);
n

93 print_misa();

n

95 for (int i=0;i<20; i

) {

K 7-14 TSR EN R

5
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7.1.4. TEBITERF

VAP A RIS, TRCE R T8O R e 7-15, s FRAED R 21T
X, Sbit 2o bR 2 V4o SR (g T3, Rl AU T BT kiR FE47 . TR~
BISAT AR FE B E S, PTUAREREE . WK 7-16, A LA 2 H HIERTTEIH
helloworld %5 5. FEWIIFER:, WK 7-17, 7E console ¥4 H T st 4 Bz £l Wi T Hz .

8 CPDE - NucleiStudio = [l X
File Edit Sou <en||Ng|smn|,|R RV-Tools Window Help
<= @ L. ellowortd debug o~ R T R - I WP E TS TG HTO TR idE S SRS Quick Access]| & |8l #
P”“"---' o . -

&Bi ebu An outi t availabl

nc

nuclei_sc

1_helloworld_debug_openocd launch

e

O Console
DT Build Console [nucleisdk]

K 7-15 FaEREFEUT AR FIEAT

ARSCAE PR A BRI SR B T, REERBHCR e P al, APHER. S HI sl A SO 2 2 sih o N . R 78
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@ CPDE - NucleiStudio

- o X
File Edit Source Refactor Navigate Search Project Run RV-Tools Window Help
%/[0][®] 0Run ~ | @ hello_world_debug ¢~ | '™ v B A LB O 2WD A E LG ETO A ATISE T THrtevo. [Quick Access|!| @ | B
& Project Explorer Ble =0 “ B =Outline = ¥ Task 1. %Dow. =8
~ & hello_world v

& Binaries An outline is not available.

# Includes

& application

& Debug

& nuclei_sdk

hello_world_debug_openocd.Jaunch

1% Problems < Tasks ©Console = Properties & Terminal ©
2coMn

Nuclei SDK Build Time: Aug 6 2020, 11:40:17
Download Mode: ILM

CPU Frequency 5001707 Hz

MISA: x4014912d

MISA: RV32IMACFDSPU

: Hello World From Nuclei RISC-V Processor!
: Hello World From Nuclei RISC-V Processor!
: Hello World From Nuclei RISC-V Processor!
Hello World From Nuclei RISC-V Processor!
Hello World From Nuclei RISC-V Processor!
: Hello World From Nuclei RISC-V Processor!
: Hello World From Nuclei RISC-V Processor!
: Hello World From Nuclei RISC-V Processor!
: Hello World From Nuclei RISC-V Processor!
Hello World From Nuclei RISC-V Processor!
: Hello World From Nuclei RISC-V Processor!
: Hello World From Nuclei RISC-V Processor!
: Hello World From Nuclei RISC-V Processor!
World From Nuclei RISC-V Processor!
World From Nuclei RISC-V Processor!
World From Nuclei RISC-V Processor!
World From Nuclei RISC-V Processor!
World From Nuclei RISC-V Processor!
wWorld From Nuclei RISC-V Processor!
World From Nuclei RISC-V Processor!

=R AR SN ] #e0

CHNONbUNES

BHEE R G E e
beloahbunibe?
Txxrrxx
TosmD 00
R R R RE
LEoEEED
65666560

Connected - Encoding: Default (ISO-8859-1)

K 7-16 8 D) T 5 g ) Hello World

@ CPDE - NucleiStudio - o X
File Edit Source Refactor Navigate Search Project Run RV-Tools Window Help

U & WP EAvErerGrikvOrRvATiS®

%[0/[=] ORun « @1 _helioworld_debug_~ ©| ' ~ LRA S Ral-ThY
& Project Explorer 8%ie == “ 2 EOutline © ask List ild Tar... % ur " a
v & 1_helloworld

Quick Access|:| & |+

# Binaries An outline is not available.
# Includes

application

& Debug

nuclei sdk

1_helloworld_debug_openocd launch

£ Problems # Tasks © Console * [ Properties #Terminal = Disassembly % Progress
1_helloworld_debug_openocd [GDB OpenOCD Debugging] openocd.exe
(3276) hpmcounterllh (/32)
(3277) hpmcounterizh (/32)
(3278) hpmcounterish (/32)
(3279) hpmcounteriah (/32)
(3288) hpmcounteriSh (/32)
(3281) hpmcounter1sh (/32)
(3282) hpmcounteri7h (/32)
(3283) hpmcounterish (/32)
(3284) hpmcounter1dh (/32)
(3285) hpmcounter2eh (/32)
(3286) hpmcounter2ih (/32)
(3287) hpmcounter22h (/32)
(3288) hpmcounter23h (/32)
(3289) hpmcounter2ah (/32)
(3290) hpmcounter25h (/32)
(3291) hpmcounter26h (/32)
(3292) hpmcounter27h (/32)
(3293) hpmcounter2sh (/32)
(3294) hpmcounter29h (/32)
(3295) hpmcounter3eh (/32)
(3296) hpmcounter3ih (/32)
(3922) mvendorid (/32)
(3923) marchid (/32)
(3924) mimpid (/32)

(3925) mhartid (/32)
(a161) priv (/8)

Bl 7-17 N 3ESE R 4L AR A W T
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7.2. f£H J-Link HXE75H
7.2.1. %% )-Link B3h SN RTT XX

HummingBird Evaluation Board 32 ¥ f] J-Link . #ifE SEGGER & M J-Link UL [H
(https://www.segger.com/downloads/jlink/#J-LinkSoftwareAndDocumentationPack), & H
CHERIE RS T 8EBOHTIY J-Link 3X3)Jf 223 . VER, J-Link IR HE T v6.62 A

GRARAE A CVEAT AT ENS Y, ) ml DARSE AT JF 82 N2 . W RABAE ] J-Link (19 RTT 37 El4
H, IR PR .

T 2407 TAE B B T, WK 7-18, fE “Resource” I s i ZLAEFRIE () IR PLE T T T
FERTAERI H . WE 7-19, £ “nuclei_sdk/SoC/demosoc/Common/Source/Stubs” 4% T #
A “SEGGER” A3, b FRAF RTT AHIG LA

& Properties for 1_helloworld O X
ty':)e filter text Resource Cyov
.@ Path: /1 helloworld
Builders .
C/C++ Build Type: Project
v C/C++ General Location: D:ACPDE\T_helloworld
Code Analysis Last modified: 2020585 6H T48:.06:48
Documentation Text file encoding
File Types (® Inherited from container (GBK)
Formatter O Other: |GBK
Indexer . i
Language Mappings [ Store the encoding of derived resources separately
Paths and Symbols New text file line delimiter
Preprocessor Include Pa | (@) Inherited from container (Windows)
Profiling Categories () Other: Windows
Linux Tools Path
MCU

Project Natures
Project References
Run/Debug Settings
Task Repository

Task Tags

Validation

WikiText
< > Restore Defaults Apply
@ Apply and Close Cancel

7-18 I LREP{E H 3
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¥ s | Stubs - O X
bl = = =A e
«~ v 1T « SoC » hbird » Common » Source » Stubs v O EFE"Stubs’ o

SEGGER  ~ @i ' i EIER sz
Syscalls [ secGer 2020/8/17 10:18 sl |
@ OneDrive ] close.c C 3z
) ] fstat.c C 344
= B +] gettimeofday.c C St
L EIBLE o isatty.c C 324
B asm o Iseekc C it
= EE «l read.c C 3744
3 i ..:sbrlb(.:] C 1‘
@] stub| H 3z¢
4 TH . an
wl write.c C 344
b ER
W =m
£ .9 Windows ((
«+ Data (D)
P s
< >
10 M8

7-19 ¥ree “SEGGER” {3

LIS AT IT J-Link KSR H3%, 4 “Samples -> RTT” #§42 ~ )
“SEGGER_RTT_V68od.zip” fft/k4f (BARELGE 4 T REARAA R ARL) o MR IE 485 301
W4 E 7-20, % RTT X3 T “SEGGER_RTT.c” , “SEGGER_RTT.h” Al
“SEGGER_RTT_Conf.h” =ANSCFLL K Syscalls U )
“SEGGER_RTT_Syscalls_ GCC.c” X204 & il 31| < Fi#r &2 i) SEGGER A erh, fx 5t
7-21 flisn. £ IDE 37 JF “SEGGER_RTT_Syscalls. GCC.c” , fE 7-22, 18 “#include
<reent.h>” Fr7ERIX—47

AN PITIR A BB ER BT, RSP R TIRA, AMSAERR . S Sl e A SO 2 A iR sl A R 81



R
NUCLEI

| ¥ = = | SEGGER RTT V680d - | X
*m  #z &8 )
« v 1 « Jlink > Samples > RTT > SEGGER_RTT V680d |0 | {E®E"SEGGER RTT ... 0
2020084 A &k : 1R IR e Foh
nuclei_ide Examples 2020/8/17 11:14 i
SEGGER RTT 2020/8/17 11:14 prales
SEGGER Syscalls 2020/8/17 11:14 s
L : ASTRY
& OneDrive - License.txt 2020/5/25 22:54 AR
— README.txt 2020/5/25 22:54 AR
W R
N EDE O
B
= Bl
x|
¥+ T
b aEx
W =\
£ 4 Windows (1
Snatama Y€ >
5 I ==
7-20 E4a N SN
4 = | SEGGER - O X
— v 1 « hbird » Common » Source » Stubs » SEGGER v U 1EBE="SEGGER" R
nuclei ide » &R B e EE sem
SEGGER ) SEGGER RTT.c 2020/6/28 15:41 Cxft
SEGGER ) SEGGER _RTT.h 2020/6/28 15:41 H 324
@ OneDrive 'f'] SEGGER RTT Confh 2020/6/28 15:41 H 3zi4
) SEGGER_RTT Syscalls GCC.c 2020/8/17 10:22 C 3zf4
= e
B 3D &
L E
=Bk
& e
4 TF
D EE
W =m
% 9 Windows ((
« ' Data (D:)
. L 4 >
4478 j -

K 7-21 55 SEGGER xRN
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- [« X

&
1 9

@ CPDE - 1_helloworld/nuclei_sdk/SoC/hbird/Common/Source/Stubs/SEGGER/SEGGER_RTT Syscalls GCC.c - NucleiStudio
File Edit Source Refactor Navigate Search Project Run RV-Tools Window Help
&|[%][m] +Debug 11_helioworld Debug o~ 5@ ~iein ¢ - = SO R O AUvING 4 widv v Quick Access|:| & | @&
 Project Explorer =% v & mainc EGGER RIT Syscalls GCC.c Slev " T 5 iRegisters = ¢ o -
~ & 1_helloworld 43 - LTS
 Binaries 44
# Includes 4
a6 *
& application 4
& Debug
~ & nuclei sdk
= NMSIS
v @ SoC
“ & hbird
& Board
v & Common
& Include
v & Source
& Drivers
= GCC
“ & Stubs
+ & SEGGER
5 SEGGER RTT Confh

5_GCC.c
tions for using prin
or printf output,

% SEGGER RTTh
: close.c
< fstat.c
¢ gettimeofday.c
2 isatty.c
: lseek.c
 read.c
& sbrkc
& stubh
< write.c
2 hbird_common.c
@ system_hbird.c
1_helloworld_debug_openocd Jaunch

reent struct
the used standard library.

@ Console

No consoles to display at this time.

Writable Smartinsert  61:1

Bl 7-22 R Sk S0

IR INSE UG Wi SEGGER S #8814 2 include, 0E 7-23, T 401 TAER R E T
[f, ¥ SEGGER (A4 #%4£ % include 7,

AR N E RSO G RBHOM KA, REURBHRE I, AR sl e A2 A i sl A T 83
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@ Properties for 1_helloworld X
type filter text Settings yeovs
Resource = = = = ~
Builders
v C/C++ Build

Build Variables

Environment

Logging

Settings

Tool Chain Editor
C/C++ General
Linux Tools Path
MCU
Project Natures
Project References
Run/Debug Settings
Task Repository
Task Tags
Validation
WikiText

® Tool Settings & Toolchains B Devices O Container Settings # Build Steps

<

<

<

<

<

<

<

% Target Processor

& Optimization

& Warnings

% Debugging

® GNU RISC-V Cross Assembler

Include paths (-1)

"${workspace loc;/${ProjName}/nuclei sdk/SoC/hbird/Board/hbird eval/Include}”
"${workspace loc;/${ProjName}/application}”
'$[w0rkspace_\oc:/${ProjName}/nucIe'\_sdk/NMSIS/Core/\nc\ude}'

Build Artifact [ Binary Parsers @ Error Parsers

'$[w0rkspa(e \0(:/${Pr0jName}/nucIe'\ sdk/SoC/hbird/Common/Source/Stubs/SEGGER}"

a8 8id

(2 Preprocessor
2 Includes
& Warnings

& Miscellaneous
® GNU RISC-V Cross C

Include system paths (-isystem)

aa il

(2 Preprocessor
& Includes
2 Optimization

2 Warnings

& Miscellaneous
& GNU RISC-V Cross C++ Compiler

22 Prep rocess:/

2 Optimization

2 Warnings
& Miscellaneous

> A Include & 1 B MISEGGER R k% 11

® GNU RISC-V Cross C++ Linker

Include files (-include)

aa il

2 General
& Libraries
& Miscellaneous
® GNU RISC-V Cross Create Flash Image
& General
® GNU RISC-V Cross Create Listing
2 General
® GNU RISC-V Cross Print Size
@ General

)

Apply and Close

Cancel

7-23 ¥/ SEGGER X3 #4122 Include

T R R IR A B write 3. WK 7-24, {E

“nuclei_sdk/SoC/hbird/Common/Source/Stubs” T[] “write.c” /a4, %EHF

“Resource Configurations —> Exclude from Build” . #1® 7-25, %% “Select All” , fiid;
“OK” . PAJEan ARk [l fdi B & 4T ER, /] LU AR R 77 X Bk SEGGER U4 4T
“write.c” CHFAINIE] TR

AR N E RSO G RBHOM KA, REURBHRE I, AR sl e A2 A i sl A
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@ CPDE - 1_helloworld/application/main.c - NucleiStudio

File Edit Source Refactor Navigate Search Project Run RV-Tools Window Help

&|[#%][m] + Debug I1_helloworld Debug o
 Debug - Project Explorer New
~ & 1_helloworld Open

 Binaries Open With

# Includes

o Show in Local Terminal
« & application

Ctri+Alt+Shift+Down

S RN . SO HTOTATISE AT AT r3-
>
a_bits.b.s) {
a_chars[index++] = 'S';
>
5 fa_bits.b.p) {
a_chars[index++] = 'P';
Ctrl+C

CirliV | bits.b.t) {
Delete fa_chars[index++] = 'T';

a_bits.b.u) {
a_chars[index++] = 'U';

F2 ja_bits.b.x) {
a_chars[index++] = 'X';

F5 lars[index++] = "\0';

2 MISA: BUES\Cint misa chars);

4 main & Copy
= Debug Paste
v & nuclei_sdk ® Delete
NMSIS Remove from Context
v &Sl Source
~ & hbird Move...
 Board Rename
v & Common
Import.
include - g8
~ = Source
& Drivers Refresh
& GCC Index
~ & Stubs

=SECEE b iling Tools
close.c
fotare | Validate
gettie © SDK Configuration Tools
: isatty, ¥ Run C/C++ Code Analysis
lseek e Team

:readc  Compare With
Esbrkc  Replace With

Properties
= write.c
@ hbird_common.c
2 system hbird.c
1_helloworld_debug_openocd launch

< /1 helloworld/nuclei sdk/SoC/hbird/Common/Source/Stubs/write.c

7.2.2. &3+ B & Debug Configuration

Exclude from Build...

Ctri+s —Bet_rv_cycle() | _get_rv_instret() | _RV_CSR_READ(CSR_MCYCLE));
t rval = rand();
t misa = _RV_CSR_READ(CSR_MISA);

"MISA: @x¥lx\rin®, misa);
isa();

Alt+Enter |t i =@; i < 20; i ++) {

}

return 8;

. I
GNU MCU Eclipse Packs console
Extracting devices & boards...
Mo installed packages.
Completed in lms.

2020-28-17 11:33:18
Extracting devices & boards...
Mo installed packages.
Completed in lms.

printf(“%d: Hello World From Nuclei RISC-V Processor!\r\n", i);

Q@ Consale

7-24 77 Exclude from Build

@ Exclude from build

O X

Exclude object(s) from build in the following configurations

Debug
Release

Select All Deselect All

Cancel

7-25 % write.c i

B AL E J-Link 0 T4k Debug Configuration #5540

- o b3
Quick Access|| | R
-y 5  WiRegisters = © % =
s=|r Name Value Descripti
Name Type Value
. R d=hd
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B ESEHAF LS “Run—>Debug Configurations” .

B R 7-26, FEFEHEE DS, WERERAE 4T TEN KK ENS, HEBT “GDB
SEGGER J-Link Debugging” , ## “New Configuration” , ¥ 2 WA H #raH—4
WX H “1_helloworld Debug” , WiE 7-27. #fiff “Project” 241 7 Z K T

&, “C/C++ Application” Hie#% 7 1R 0 75 2218 1) ELF 3.

@ Debug Configurations

Create, manage, and run configurations

L [E%~ Configure launch settings from this dialog:
type filter text
[ C/C++ Application
[ C/C++ Attach to Application
&1 C/C++ Container Launcher
[ C/C++ Postmortem Debugger | = - Press the ‘Duplicate’ button to copy the selected configuration.
[ C/C++ Remote Application
Ci C/C++ Unit
[ GDB Hardware Debugging
v [ GDB OpenOCD Debugging - Edit or view an existing configuration by selecting it.

- Press the 'New Configuration' button to create a configuration of the selected type.
[# - Press the 'New Prototype’ butten to create a launch configuration prototype of the selected type.

& - Press the "Export’ button to export the selected configurations.

% - Press the 'Delete’ button to remove the selected configuration.

v - Press the 'Filter' button to configure filtering options.

1_helloworld_debug_openoc| [ - Select launch configuration(s) and then select ‘Link Prototype’ menu item to link a prototype.
New_configuration

=] GDB PyOCD Debugging

=1 GDB QEMU Debuggin [® - Select launch configuration(s) and then select 'Reset with Prototype Values' menu item to reset with prototype values.
« |= GDB SEGGER J-Link Debuggina
= 1_helloworld Debug New Configuration gs from the 'Perspectives' preference page.

& Launch Group # New Prototype

# Launch Group (Deprecated) - Export..
Duplicate
Delete

[u - Select launch configuration(s) and then select 'Unlink Prototype’ menu item to unlink a prototype.

i Link Prototype...
Unlink Prototype
# Reset with Prototype Values

< >
Filter matched 16 of 18 items

@

Debug

L

Close

K] 7-26 & J-Link Debug Configuration

ARSCAE PR A BRI SR B T, REERBHECER S T, AHERE. SR s i A S 2 il oy WA
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@ Debug Configurations

FoREXER

type filter text

[ C/C++ Application

[ C/C++ Attach to Application

&1 C/C++ Container Launcher

[ C/C++ Postmortem Debugger

[ C/C++ Remote Application

€ C/C++ Unit

[ GDB Hardware Debugging

£ GDB OpenOCD Debugging
1_helloworld_debug_openoc
New_configuration

=] GDB PyOCD Debugging

=] GDB QEMU Debugging

=1 GDB SEGGER J-Link Debugging
[z 1_helloworld Debug

& Launch Group

# Launch Group (Deprecated)

<

<

< >
Filter matched 16 of 18 items

Create, manage, and run configurations

Name:hﬁe\\owor\d Debug

[ Main . % Debugger| & Startup % Source T Common % SVD Path

Project:

| 1_helloworld |

Browse...

C/C++ Application:

| Debug\1_helloworld.elf |

Build (if required) before launching
Build Configuration: Select Automatically

(O Enable auto build
(® Use workspace settings

Variables... Search Project... Browse...

() Disable auto build
Configure Workspace Settings...

Revert Apply

7-27 Hfx Project 1 C/C++ Application 5 L —%

T Debugger #~H, UK 7-28.

Wik 1 547 E “Start the J-Link GDB server locally” #i%r.

o 5 B 1IE#i35 [ JLinkGDBServerCL.exe 1542,

3 TR HATEHNRZ, XHEELN3o7 AFI, HA N3o7 BIF] . wiffi A RV-STAR JF &
B, X HHN GD32VF103VBT6. Wi ] HAth - K& #5525 J-Link Support Device W 71, 454
R https://www.segger.com/downloads/supported-devices.php

4 ik “Interface” Ny JTAG,

ARSCAE PR A BRI SR B T, REERBHCR e P al, APHER. S HI sl A SO 2 2 sih o N .

“initial speed” N Auto.
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5 SN S HIA) GDB & — .

MRAEBRHIANE, il 6 SALE “Apply” /{7

@ Run Configurations

Create, manage, and run configurations

CReEX[E3~

7 Build Docker Image

1C/C++ Application

1C/C++ Container Launcher

JC/C++ Remote Application

i C/C++ Unit

» Docker Compose

7GDB OpenOCD Debugging
[1_helloworld_debug_openocd
[© coremark_debug_openocd
[ cos_debug_openocd
[ demodsp_debug_openocd
[c] demotimer_debug_openocd
[c] dhrystone_debug_openocd
[c] flashhelloworld_debug_openocd
[=] free_debug_openocd
=] helloworld_debug_openocd
= New_configuration
[= plic_debug_openocd
Ertth_debug_openocd
[ whetstone_debug_openocd

7GDB PyOCD Debugging

1GDB QEMU Debugging

71 GDB SEGGER J-Link Debugging
[c]1_helloworld Debug

i Launch Group

+ Launch Group (Deprecated)
Launch over Serial

# Run Docker Image

< >
Filter matched 28 of 30 items

Name: ‘LheHnwor\d Debug

[ Main|# Debugger - & Star‘[up} % Snurcsﬂ = Cnmmnn} % SVD Path]

J-Link GDB Server Setup

(1]
|/ Start the J-Link GDB server locall (2]

["]Connect to running target

Executable path: [ ${jlink_path}/${jlink_gdbserver}

Browse... Variables...

Actual executablel] C:/Program Files (x86)/SEGGER/JLink/JLinkGDBServerCL.exe

(to change it use the global or workspace preferences pages or the project properties page)

Device name: 9 Supported device names
Endianness: (@ Little () Big

Connection: ®Uuss OIP l—‘ (USB serial or IP name/address)

Interface: (OSWD (® JTAG

Initial speed: (® Auto () Adap ) Fixed kHz! o

GDB port: 2331

SWO port: Verify downloads [| Initialize registers on start
Telnet port: Local host only [ ] Silent

Log file: ‘ Browse...

Other options: ‘fsw'ng\erun -strict -timeout 0 -nogui

Allocate console for the GDB server

GDB Client Setup [5)

Allocate console for semihosting and SWO

Executable name: J${cross_prefix}jgdb${cross suffix}

Browse...| Variables...

Actual executable:friscv-nuclei-elf-gdb

Other options:

Commands: set mem inaccessible-by-default off

Remote Target
Host name or IP address: localhost
Port number: 2331

[]Force thread list update on suspend

Restore defaults

5]

I Apply I

Revert

@ Close
7-28 ¥ & Debugger ¥ H AN %
F1HF “Startup” £ H, @ 7-29, #ifr JTAG/SWD Speed & Auto, “set Breakpoint at
main” , “Continue” , “Pre-run/Restart reset” 1 “RAM application” #&Ifi#zik, I+ HE

W/a)i% “Initial Reset and Halt” £,

AR N E RSO G RBHOM KA, REURBHRE I, AR sl e A2 A i sl A
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@ Run Configurations

Create, manage, and run configurations

CEeRX B2~

type filter text

<

<

£ Build Docker Image

[E1C/C++ Application

€1 C/C++ Container Launcher

[E1C/C++ Remote Application

€ C/C++ Unit

© Docker Compose

[£1GDB OpenOCD Debugging
£ 1_helloworld_debug_openocd
[ 2_helloworld_debug_openocd

[E1GDB PyOCD Debugging

=1 GDB QEMU Debugging

[ GDB SEGGER J-Link Debugging
=1 1_helloworld Debug

& Launch Group

X

Name: ‘1_he|\0w0r\d Debug

B Main | % Debugger | & Startup
Initialization Commands

& Source| ™ Common| £ SVD Path

[ 1Initial Reset and Halt Type:

Low speed: 1000 kHz

JTAG/SWD Speed: ® Auto () Adaptive () Fixed

kHz

Enable flash breakpoints

Enable semihosting Console routed to: ] Telnet /] GDB client

Enable SWO CPU freq: |0

Hz. SWO freq: 0 Hz. Port mask: Ox1

Load Symbols and Executable
Load symbols

(® Use project binary: 1_helloworld.elf

& Launch Group (Deprecated) (O Use file: Workspace... = File System...
) Launch over Serial Symbols offset (hex): |:|
4 Run Docker Image Load executable
(® Use project binary: 1_helloworld.elf
(O Use file: Workspace... = File System...
Executable offset (hex): |:|
Runtime Options
I] RAM application (reload after each reset/restart) |
Run/Restart Commands
Pre-run/Restart reset Type: | \ (always executed at Resta rt)l
["]Set program counter at (hex):
Set breakpoint at: main
Continue
Restore defaults
Filter matched 17 of 20 items Reverr Apply
@ Run Close

K 7-29 & & Startup 2 H N

LB ENE
I

7.2 3. FRBFF R EIRAEF

SRR, MRS N Apply (RIE R E, WIREE RS S 7 close

ff i} J-Link £ HummingBird Evaluation Board i 75 ZE B L. i 7-30, ZAERRER
#hr72 J-Link 75 BERE IR FRIER . Hoh VTref 21 1 V3.3 30, HAhH %853
JTAG #: 11, F5| ML EAEssd, —— SRR, &JESEVEsaE 7-31.

ARSCAE PR A B FIRABUN SR B T, RGBS B, AHERE . S sl e A S 2 e WA
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VTref 1(e] e2 [NC
nTRST 3@ [®4 |GND
TDI 5 ® 6 |GND
™S 7E| ® 8 |GND
TCK 9 ® 10| GND
RTCK I:u ® @ 12|GND
TDO 13[0] e 14|=x
RESET 15 @ ®16|*
DBGRQ 17 @ ®18|x
5V-Supply (19 ® ® 20| *

7-30J-Link 5l HE

J-Link VTref Pin Connection

NN & T

7-31)-Link S2¥pE K

AR N E RSO G RBHOM KA, REURBHRE I, AR sl e A2 A i sl A HHE 90
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FETT R BV R/, WA B T, REERE JTAG B & OISR A S FALE,
FHATIT R 1 DME NS Printf sREHTENE B WRAEH RTT 4TE1, 75 247JF J-Link RTT Viewer &
F printf TEME B WK 7-32, &MEEHNERE, 103 USB J7:UiE#H:. Specify Target Device
RAEAE I N R 1B 28, X LL N3o7 M|, Target Interface & Speed & N 1000kHz,
P S b S R 1E 2. RTT Control Block %% Auto Detection.

J-Link RTT Viewer V6.80d | Configura... ? X

gnnection to J-Link

[ ] Serial No

() TCP/IP
() Existing Session

Specify Target Device
N307 v

Script file (optional)

Target Interface & Speed
JTAG ~ 1000 kHz -

h ontrol Block
() Address () Search Range

J-Link automatically detects the RTT control block.

0K Cancel

K 7-32 & & RTT Viewer

K 7-33 R RuAEL T Debug, 25 /2l B bn 280y B U E by, B e B AT E N PR 2O0F T
BREFREANTT R

R BT, WINE 7-34 Fion, It H 2 E sh i .

AR N E RSO G RBHOM KA, REURBHRE I, AR sl e A2 A i sl A Wi 91
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mE 7-34 11 SN E,
Kl 7-34 B 2 ShaEME,

wmlE 7-34 1 3 ShREAME,
T Ao

mE 7-34 1 4 SHRENE,
WK 7-34 1 5 ShREME,
mE 7-34 # 6 ShaEALE,

W 7-34 1 7 SAREME,

y— S

XHEIhRe AR RL, BT, ILWMBIHIRE.
XA RN H AR P IBAT LA .

FEACHE ) 22 A0 Xty R AT AEAZ AT B B i, PR ORI LB

3 L AT BAYT) e R A R A 2
X R R BN AR R AL
XHEREE AR EEE .

s il 3 FRLZT g B0 AT DAGR HY R AR 2

e 7-34 1 8 SHRENME TJ5, X B LMEH GDB % & 15 2347 1

@ CPDE - 1_helloworld/application/main.c - NucleiStudio
File Edit Source Refactor Navigate Search Project Run RV-Tools Window Help

3 =] + Debug

Project Explc o o

& 1_hellow
€

1_helloworld_debug_openocd launch

11_helioworld Debug PR S R Al

4 main.c
if (misa_bits.b.s) {
misa_chars{index++] = 'S';

}
if (misa_bits.b.p) {
misa_chars(index++

= 'P';

; X
if (misa_bits.b.t) {
misa_chars[index++

}
if (misa_bits.b.u) {
misa_chars[index++

<

}
if (misa_bits.b.x) {
misa_chars[index++

}

misa_chars[index++] = "\@';

printf("MISA: RVEs\r\n", misa_chars);

83-int main(void)
4 {

VO EvEvEvEviEvOvhvAviNE FviEH el viiveoyo Quick Access|| & | #

= Outline
~ AR env

u stdioh

u timeh

u stdlibh

u nuclei_sdk soch

» print_misa(void)

* main(void) :int

srand(__get_rv_cycle() | _get_rv_instret() | __RV_CSR_READ(CSR_MCYCLE));
a0}

uint32¢ rval = ran
rv_csr_t misa =

printf("MISA: exXlx\r\n", misa);

© Console
CDT Build Console [1_helloworld]
19:15:38 **** Incremental Build of
make all
Invoking: GNU RISC-V Cross Print Size

RV_CSR_READ(CSR_MISA);

A E-R -

configuration Debug for project 1_helloworld ****

riscv-nuclei-elf-size --formatsberkeley "1_helloworld.elf"

text data bss dec
8394 112 3448 11954
Finished building: 1_helloworld.siz

19:15:38 Build Finished. @ errors

hex filename
2eb2 1_helloworld.elf

, @ warnings. (took 325ms)

Writable Smart Insert  95:1

7-33 Ui A T HHQ
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@ NucleiStudio_workspace - helloworld/application/main.c - NucleiStudio IDE
File Edit Source Refactor Navigate Search Project Run RV-Tools Window Help

0

&[% [®] Debug  ~ Ehelloworld debug op | [ ¥ wvrovavessvsafrienan TeE TE]weil iy vl
#Debug & Project Explorer = “mainc @ maine  ©(gdbl1}proc|42000] threadGroupli1Lgdbl1)proc[42000] OSthread(1]) thread (1] frame(0]
+ Ehelloworld_debug_openocd [GDB OpenOCD Debugging) iF (misa_bits.b.p) {
~ @& helloworld elf misa_chars[index++] = 'P';
- # : }
# Thiead #1 (suspended:step) b cmisabitnbty ¢
= main{) at main 95 0xB00001dc mica chars[indexs+] = T
£ openocd exe 3
1 riscy-nuclei-¢lf-gdb if (misa_bits.b.u) {
misa_chars[indext+] = 'U';
73 3
74 AF (misa bits.b.v) {
misa_chars[index++] = V'3
%
77 iF (misa_bits.b.x) {
78 misa_chars[index++] = 'X';
9 }

mis

pri

mads
sra

uin

pri

. L. pri

@ Current Position
“u

5
© Break Point—"" }

ret

BConsole P
helloworld_deb
Breakpoint 3
92

7.2.4. TREBITERF

Py_

a_chars[index++] = "\@';

NtF("MISA: RVEs\r\n", misa_chars);

n(void)

nd(__get_rv_cycle() | _get_rv_instret() | _RV_CSR_READ(CSR_MCYCLE));

32t rval = rand();
csr_t misa = _RV_CSR_READ(CSR_MISA);
ntf("MISA: BxXlx\rin", misa);
nt_misa();

for (int i = @; i < 20;

) {
printf("%d: Hello Hor‘ld From Nuclei RISC-V Processor!\r\n", i);

urn @;

)

ug_openocd [GDB Open aTSleroms. prefixigdbs cross suffix) (227)
, main () at ../spplica: 92
printf("MISA: @x¥1x\r\n", misa);

print_misa();

for (int i = 8; i < 20; i ++) {

K 7-34 T Ua N R T

Type
int

uint32_t
v esrt

Name
i
o rval
o misa

<

Name : misa
Details: 1875889782
Default:1e75e897e9
Decimal: 1875883789
Hex:@x4014912d
Binary:1000000000101001¢
Octal: 018885118455

“Registers
Mame
t4
5
16
e
o
it
itz
3
it
its
6
it
fs0
sl
fa0
fal
fa2
fa3
fad
fas
faf

lame : pc
Hex:@:
Decim
Octa.
Binar
Defau:

x80000fdc
al:-2147479588
1820000007734

"y : 1822000088800008¢
1t:exseeeefdc <mair

;
o@e- -

TR A LR BUS , AT F BT RAR . ke 7-35, sk RN D) S T

Ao BRI 22 B br 2 D)oy 2R

iBATHAE, BRI AR R EE I R RORE

N— S

&7

BT AT

AT BB S, FTUATREHXREE. WK 7-36, A LLFEF| RTT Viewer 1EHFTED H

helloworld %5{5 2. R T LW iEH:, r 7-37, £ console £ H

.

N e 2L BH B AT

AR N AU SRR R A

REEARRH IR, ALk, =l

EREA S 2 2R N &
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@ CPDE - 1_hellowa ication/main.c - NucleiStudio - =/

File Edit Source Refa

ate Search Project Run RV-Tools Window Help

#][0Run 1 helloworld Debug - Sv&vi @O OB Ol N0k A BD A SN el
Project Explge=s main.c Outline
« &1_hellowdemm if (misa_bit (

dex+s] = 'S7; = stdioh

& Binarie * Debug . misa_chars N
Includes SR u timeh
application misa_chars(ind@++] = 'P'; u stdiibh
mainc u nudlei sdk soch
Debug « print_misa(void) : void
~ & nuclei_sdk =T * main(void)
NMSIS

Soc

1_helloworld_debug_openocd.launch

misa_chars[index++] = '\0';

printf(“MISA: RVEs\r\n“, misa_chars);

int main(void)

srand(_get_rv_cycle() | _get_rv_instret() | _RV_CSR_READ(CSR_MCYCLE));
ui al = rand();
SR_READ(CSR_MISA);

printf( n", misa); v

eley "1_helloworld.elf"
hex filename

8394 112 3448 11954  2eb2 1_helloworld.elf
Finished building: 1_helloworld.siz

19:15:38 Build Finished. @ errors, © warnings. (took 325ms)

Writable Smart Insert | 78:32

7-35 TEREFRITT AR His AT

J*L\'nk RTT Viewer V6.80d — O e

File Terminals Input Logging Help
411 Terminals Terminal O

Nuclei SDK Build Time: Aug 17 2020, 18:52:11
Download Mode: ILM

CPU Frequency 5060724 Hz

MISA: ©x4014912d

MISA: RV32IMACFDSPU

: Hello World From Nuclei RISC-V Processor!
Hello World From Nuclei RISC-V Processor!
Hello World From Nuclei RISC-V Processor!
Hello World From Nuclei RISC-V Processor!
Hello World From Nuclei RISC-V Processor!
Hello World From Nuclei RISC-V Processor!
Hello World From Nuclei RISC-V Processor!
Hello World From Nuclei RISC-V Processor!
Hello World From Nuclei RISC-V Processor!
Hello World From Nuclei RISC-V Processor!
: Hello World From Nuclei RISC-V Processor!
: Hello World From Nuclei RISC-V Processor!
: Hello World From Nuclei RISC-V Processor!
: Hello World From Nuclei RISC-V Processor!
: Hello World From Nuclei RISC-V Processor!
: Hello World From Nuclei RISC-V Processor!
: Hello World From Nuclei RISC-V Processor!
: Hello World From Nuclei RISC-V Processor!
: Hello World From Nuclei RISC-V Processor!

POUONOURAWNRE®

| Enter Clear

Temp. halted CPU for
HW instruction/
Support set/clr BPs while running:

HW data BPs trigger befo ution of inst

ATT Viewsr connected. 0. 004 NB

Kl 7-36 FTENfiH Hello World

ARSCAEPITIR A BRI SR B T, RGP

SHIHEAL, AHERE . ST BB R A S 2 2R el

B

553
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@ CPDE - 1_helloworld/application/main.c - NucleiStudio u] X

File Edit Source Refactor Navigate Search Project Run RV-Tools Window Help

4//0 (=] ORun 0 1_helioworld Debug oy Bvavi@®vON - LW P AvEvEvEvT HvOTR YAy ST~ « 4 v §iwe vow Quick Access|: @ | &
Project Explorer v 4 main.c = ©10x200001ca Outline

~ & 1_helloworld 62 if (misa_l lnts b.s) { i AW
> 63 misa, rs(index++] = 'S'; & i
i( ( bits.b.p) { timeh
misa_bits.b.p
misa_chars[index++] = ‘P u udl;hh -
} nuclei_sdk soc )
if (misa_bits.b.t) { = print_misa(void) : void

misa_chars[index++] = 'T';

* main(void)

if (misa_bits.b.u) {
misa_chars[index++

<

1_helloworld_debug_openocd launch 73 }
7 if (misa_bits.b.x) {
misa_chars[index++

}

misa_chars[index++] = "\@';|

printf("MISA: RVEs\r\n", misa_chars);

83-int main(void)

srand(__get_rv. y le() | _get_rv_instret() | __RV_CSR_READ(CSR_MCYCLE));
uint32 ¢ rval =
rv_csr_t misa = RV CSR READ(CSR_MISA);

printf("MISA: @x%lx\r\n", misa); v

1_helloworld Debu gmuﬁskoutm Link Debugging] JLinkGDBServerCLe:
Downloadin, ng 460 bytes @ address ©x2@000000 - Verified OK
Downloading 7486 bytes @ address @x20000200 - Verified OK
Downloading 528 bytes @ address 8x20001EF@ - Verified OK
Downloading 112 bytes @ address 0x20002100 - Verified OK
Comparing flash  [...o..cevvveernnnnns ] Done.

Writing register (pc = @x200@0@cc)

Received monitor command: regs

X = 00000000, X1 = 00000000, X2 = G00O0000, X3 = 0000000
X4 = 00000000, X5 = 00000000, X6 = 00000000, X7 = 00200000
X8 = 00000000, X9 = PAOGG0E, X10= 0OB0E000, X1l= 00800000
X12= 00000000, X13= 00000000, X14= 00000000, X15= 00000000
X16= 00000000, X17= 00000000, X18= 00000000, X19= 00000000
X20= 00000000, X21= 00000000, X22= 00000000, X23= 00002000
X24= 00000000, X25= 0000A0G, X26= AOREGR, X27= 0GBEEE00
X28= 00000000, X29= 80000000, X30= 00000000, X3l= 80020000
PC = 200000CC

Reading all registers

Starting target CPU...

Writable Smart Insert 78:32

7-37 T EGE R AL A W T R

8. 2B A Nuclei Studio A& K TE

Nuclei Studio M 2020.08 AT 4G, B 7 L BB M GNU MCU RISC-V GCC (riscv-none-
embed-gce) F+ 2% 21| RISC-V Nuclei GCC (riscv-nuclei-elf-gee), K NgmiEardt kA2, AT LMEH
201909 K 2 BIHA R IDE A T2, 2R E 54 7T AIEH A IDE . x5 LA
201909 fii A< f¥] Nuclei Studio 4 i f¥) helloworld T %, HS N BB E K VEH D BATF

B $A 201909 FRAAE AL helloworld T2, MM SATRIESH 5.2 71, XEAHE

B FALREEALERE “Properties” FTJT W E WA, ##F “C/C++ Build - Settings” ,
$TFF Toolchains £ H 4R J5 /&4 Name F kTl “RISC-V Nuclei GCC (riscv-nuclei-elf-
gee)” , WfR. 1B2E R Apply RAFIZ L.

ARSCAE PR A BRI SR B T, REERBHCR e P al, APHER. S HI sl A SO 2 2 sih o N . i 95
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@ Properties for hello world O X

Settings —

Resource

Builders

C/C++ Build Configuration: Debug [ Active ] ~ | Manage Configurations...
Build Variabl

Envi t .
nvironmen ® Tool Settings ® Toolchains M Devices O Container Settings # Build Steps  Build Artifact & Binary Parsers @ Error Parsers

Logging
Name: RISC-V Nuclei GCC (riscv-nuclei-elf-gcc) VI
Tool Chain Ec Architecture: RISC-V v
C/C++ General
Linux Tools Path | Prefix:
M suftc [ ]
Project Referenc i
Run/Debug Sett C++ compiler:
Task Repository Archiver: ar
Tas.k Tags Hex/Bin converter: |objcopy
Validation Listi tor: bid
WikiText isting generator: |objdump

Size command: size

Build command:

3
2
=~
o

Remove command: rm

Toolchain path: ‘$€e(\Tpse_hume)\\toolchain\\gcc\\bin |

(to change it use the global or workspace preferences pages or the project properties page)

Build tools path: ‘$€ec\Tpseihome)\toolcham\bui\dftools\an |

(to change it use the global or workspace preferences pages or the project properties page)
[“] Create flash image

Create extended listing
Print size

< > Restore Defaults Apply
@ Apply and Close Cancel

B 8-1 &% Nuclei Studio T.E.%%

B B4 TR “Clean Project” Fi%k#¥ “Build Project” EH],

9. ' JLIH) &
9.1. Nuclei Studio &zh18

Nuclei Studio /&% T eclipse #:1THF &, 487K T eclipse (IR H &M HIHRF M & RIS, HAFAE
F AR R, 5B, PR RR BRI AR ISR A7 S B Workspace.
£ 2021.09 i) Nuclei Studio ', FATEIXSJE a0 7O, 7ERMIERE 2 HIATIR T, 5 —IK)a
3] Nuclei Studio GE1E— 735 N 578 il

Nuclei Studio F iz 7 5.

ARSCAE PR A BRI SR B T, REERBHCR e P al, APHER. S HI sl A SO 2 2 sih o N . i 96
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B  Windows 10 #:1/E &%

B 4G UL EWAE (2G AT LA Nuclei Studio 43l % H )

9.2. Nuclei Studio Z#ZEEFIRIE

FEM A AR, AT I Nuclei Studio 7£4w P50 H I 2> H IR R I, Gl fFak
L, N 360 AREEHAER, HIFERSPIUTIRIE, 1B 360 REEHIFNT, FiiEfES DL IE

HOEEAT . 9 T PRFE Nuclei Studio MIEH ], @AEM IR H 360 F55% 74 AT

9.3. #T7F/3< Launch Bar

T A “Window -> Preferences” , ##% “bar” , W@ 9-1, HUVHAESE — SR A]

<M Launch Bar. [F#, #EZ/{#H Launch Bar ThiE, &2 %,

= Preferences

m Launch Bar

RurE/Deb:_g Preferences for the Launch Bar
w Launching
[ E Enable the Launch Bar |l

@ 2 "bar" (2 SR RABYE D

< >

_ .
@ s @®

Enable the Build button
[] Always show\the target selector

Restore Defaults

Apply and Close

Apply

Cancel

9-1 3 Launch Bar

9.4. f#iH Launch Bar

Smartchip Studio 1) Launch Bar (i 5 UHE P FRVEFT 7)) A2 5320 T FAE Ak b i i ik

ARSCAE PR A BRI SR B T, REERBHECER S T, AHERE. SR s i A S 2 il oy WA
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o BN B TRESEAT g i, AR R 3B EERE, WFR A EER, Bise 5 NhAEA i
BoE N AMYE. FHELN4H Launch Bar %5843 ThRE:

‘| A \_gj \_5_‘ O Run [c] hellowcrld_debug_openoce GJG

0_

&5 Project Explorer @ Run S ¥ =8

»i=helloworld 1% Debug

9-2Launch Bar Zfg/ 28

BIAR 1 i iRade A 0 VR B N I TR . A ik TR 9 TR 5 5 N RrAEE Hh 1 v i
N TF%, FF3F Project Explorer H1ik 1K) T/

Elbr 2: 1247 /g TR B NI TR . BRAEEIRR R N HHE 4 N R4
EIbR 3: 1B H T /R .
NHIHE g VI T E/ AR Ve S ScR B 2 IBRNE.
NHAE 5: G AR E SO AR AR EAR 1. 2. 3 RN TR
WA EIAS 6: ATJF 4Tk B RC B 0w, 7 BT B R AR
9.5. AM#H Launch Bar #4TE4T /iR

XTT RV E) TR, R AMEH Launch Bar Thfg, 77 LA THE, #%4#% “Debug As ->
Debug Configurations” . £ & 1 1% 5 TR M (1) ¥ B % T, X B LA helloworld TR %1,
K 9-3, i%&#% “helloworld_debug_openocd” , ZJ5i%# “Debug” HiH1HIR.

FH, ¥IKisfTHEA G TR, %% “Run As -> Run Configurations” . £ 3 % thi%k £ T
TR BRI, 2 f5iETE “Run” FFARIZAT.
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€ Debug Configurations J X
Create, manage, and run configurations ﬁ\
[ BeEXBY - Name:|hel\oworld_debug_openocd ‘
‘type filter text ‘ E Main - # Debugger # Startup|% Source ™ Common 7. SVD Path
~ [E C/C++ Application Proiect:
helloworld.elf s
[ C/C++ Attach to Application |hE”0W0”d Browse..
[E] C/C++ Container Launcher C/C++ Application:
[ C/C++ Postmortem Debugger |Debug/he\|0w0r\d.e\f
[ C/C++ Remote Application : -
€ C/C++ Unit Variables.. | Search Project... Browse...
@ Debug Adapter Launcher Build (if required) before launching
@ DSF PDA Application Build Configuration: Select Automatically v
[ GDB Hardware Debugging
& GDB Jumper Debugging (O Enable auto build (O Disable auto build
+ [ GDB OpenOCD Debudain (® Use workspace settings Configure Workspace Settings...
I helloworld_debug_openocdl 0
GDB PyOCD Debugging
= GDB QEMU Debugging
[ GDB SEGGER J-Link Debugging
A Launch Group
Filter matched 17 of 17 items Re‘é“ Apply
® Close

K 9-3 AM#iF Launch Bar 1 it 47 it
254 RT TRE C A_L RHATI ASOE TR e, AIE Loy fek e T i R Rk, 4k
SRR R TAE R B BT . X T84T, WTRE © 7 B TFROET, PRosk En MR E
9.6. Debug MHEEEHFIes
Bt Debug #i30 )5, FIAEA LT TH FEARRESE — ]33], X BB EFAEEEH A, £35
Bk “Window -> Show View -> Registers” I H#FfE284= H . [FIFE, WRBEEERNIE, AL

% “Window -> Show View -> Memory” , A$TH =6 G, TLUESE “Window -> Show
View -> Debugger Console” , HAh i MLANAHOTE 2 /20, W H P BATARL .

9.7. Debug WHERHE

7t Debug U EIR H A, Al Sd ® B IR, AP IEFT 2 AR S EERES, 75 Debug
W, Adi Debug £2H dff)kfE, £ “Terminate / Disconnect All” S5/ Debug #fE.
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9.8. Nuclei Studio TR &5 T)8E
{£ Nuclei Studio 1, & WK THRFERT, ATERHK IR 285160 1 DI RE -
milh g BvA TR EvTE Y IO YO TE YU viOD S/ SRE T DIn|SBBErHyeorOy |

T IR e ]
- e ®
RS RTSE  RURAE TG Rt
PR E © 7, BRI Debug Al Release, FSTAT TR, X B,

w

Ui TS S , W] DALE R H7 ik 35 4 % Project Explorer 73k 1) TF2.

GrEHTE A ™, — Wi BB Project Explorer 41 T 2.

wang® Y EY YOV e rmone, AR, CHRIRARAE.
Pt T, AT U R VR AR ) TR

1517 O, TR TR R A B BRI TR

Profile ©° 7, f/ Profile S, HALH, AR,

o @~ ‘ -
HraxeXTH , WL A, P E SIRAF A .
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= =

2T A T R RITLS, A,

o § & E 1w e et
AT BE L A , A LR IT T B ARSI

pla T RS BT A G o 14,

[::-

8
Debug ] | s ATE BRI BT A W, )5 SE I Restart Zhfg.

7% CMSIS %, eclipse H7 ThAE, A CH

Nuclei SDK T2 & T.H @ , 2 6.1,

- v IO oow v|‘

=
A T A T, WTRBEPUEB, ARThRg AR

EZIAEP

9.9. BrHMEO

6 TDE f A = B er LR i Bk, H 02 C/C+ ST Debug B It
1, fEiE N Debug U, #AFE Debug WiH, <A MEIER, M A “Switch” EITA LA
J)#: % Debug T . fESEHFLHIESE “Window -> Perspective -> Open Perspective” 7] DL
PIE SN IEP

HEARFMELT, “Window -> Show View” HoRIA BB AR AR . e 9-4, 7£ Debug
W O] DUE R R R i 785 (Registers) , WA7F (Memory) Fifikizdl& (Debugger

Console) .

ARSCAE PR A BRI SR B T, REERBHECER S T, AHERE. SR s i A S 2 il oy WA i 101



R
NUCLEI

Window Help
i New Window a | | Fl ot B
Editor >
Appearance >
Show View > % Breakpoints Alt+Shift+Q, B
Perspective 5 B Console Alt+5hift+Q, C
L + Debug
Navigation > @ Debugger Console
Preferences & Debug Sources
= Disassembly
% Error Log Alt+Shift+Q, L

O Executables

@ Expressions

0 Memory

0 Memory Browser

= Modules

g Outline Alt+Shift+Q, O
Peripherals

Problems Alt+Shift+Q, X
Progress

Project Explorer

! Registers

5 Signals

& Templates

& Terminal

% Trace Control

- Variables Alt+Shift+Q, V
2 Visualizer

Other... Alt+5hift+Q, Q

EFH

9-4Debug HAEEH D EEE 1

9.10. KEMINFOME

AR “Window -> Perspective -> Reset Perspective” , 7E#E 1% “Reset
Perspective” 1] DL & & 11 BRIAAR )&

9.11. XL Py st

FHiEEE LR, %8 “Compare With -> Local History” 1 7F7 82id 5% . W1
9-5, {EFTHFHY History 4 H QU i B8 X b B9 SCHE g S RRAS, ] LA B SO A2 8l g 5
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[¢ mainc  &°Compare main.c Current and Local Revision & = =
[ C Compare
v [@ Translation Unit

° print_misa

9 C Compare Viewer £ MBE4ndR
Local: main.c Local history: main.c 2020561283300 T42:33:30
4#include <stdlib.h> 4#include <stdlib.h> ~
S#include "nuclei_sdk_soc.h” S#include "nuclei_sdk_soc.h”
6 6
7void print_misa(void) 7void print_misa(void)
8{ 8{
9 CSR_MISA_Type misa_bits = (CSR_MISA_Type) _ RV_CSR_READ( 9 CSR_MISA_Type misa_bits = (CSR_MISA_Type) _ RV_CSR_R
1e static char misa_chars[30]; 10 static char misa_chars[30];
11 uint8_t index = ©; 11 uint8_t index = ©;
12 if (misa_bits.b.mxl == 1) { 12 if (misa_bits.b.mxl == 1) {
13 misa_chars[index++] = '3"; 13 misa_chars[index++] = ‘3‘;
14 misa_chars[index++] = '2'; 14 misa_chars[index++] = '2"
15 } else if (misa_bits.b. mxl 2) { 15 } else if (misa_bits.b. mxl == 2) {
16 misa_chars[index++] = 16 misa_chars[index++] = "
17 misa_chars[index++] = 17 misa_chars[index++] = H
18 } else if (misa_bits.b.mx ) { 18 } else if (misa_bits.b.mxl == 3) {
19 misa_chars[index++] = 19 misa_chars[index++] = 'L";
20 misa_chars[index++] = 20 misa_chars[index++] = '2";
21 misa_chars[index++] = '8"; 21 misa_chars[index++] = '8";
22 )3 3
[ 23] b7 23 if (misa_bits.b.i) {
24 if (misa_bits.b.i) { 24 misa_chars[index++] = 'I";
25 misa_chars[index++] = 'I"; 25 ¥
26 } 26 if (misa_bits.b.m) {
27 if (misa bits.b.m) { 27 misa charsfindex++1 = 'M": 4
< > < >

¥ Problems ¥ITasks & Console = Properties & History #
main.c
Revision Time

= 2020/12/31 £510:22

= 2020/12/31 £E49:30

= 2020/12/31 £549:29

= 2020/12/30 F42:33

B 9-5 xf kb s

9.12. B THEM A 58 tH IR 4

B THER IDE FRER A TR, R ENER TN AR RV ZE, 7]
S BRIP4 error, K545 JE error 2iE . WHILCA EILS, 1K DA & A i d N
.

9.13. #¥ Include BB HINER

£ include TURUET G R AT, FIRESS HIIMZAF I BRAR A2, IR s Workspace B¢ File
System 1 H Ji5 W] 78 55 H A 45

9.14. HEWHI HIRAZR

A ATRERDYHE KN, B> B EAS AR, Wl 9-6, W RidyZLHE A 2 A5 5 1A
WRBEEAE H
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]
type filter text Settings vor
Resource
~
Builders X . . - -
v C/C++ Build Configuration: |Debug [ Active ] ~  Manage Configurations...
Build Variabl
f;;l;x;gmmt ® Tool Settings # Toolchains B Devices 0 Container Settings # Build Steps " Build Artila(tE
i
Settings Name: RISC-V Nuclei GCC (riscv-nuclei-elf-gcc)
Tool Chain Ec | arcpitecture: RISC-V v
w C/C++ General
Prefix: riscv-nuclei-elf-
C/C++ Langu e gl A o g (A
: ) stz 7] Beb il ) £
Code Analysi Suffix: [' lt&t J\l = 'hiﬁ/j* r I
Documentati C compiler: acc
File Types c iler
Formatter ++ compiler g++
Indexer Archiver: ar

Language M: Hex/Bin converter: |objcopy
Paths and Syi
Preprocessor
Profiling Cate Size command: size

Listing generator: | objdump

Linux Tools Path Build command:  make
MCU
Project Natures

Project Referenc
Run/Debug Set! Toolchain path: ${eclipse_home}\toolchain\gcc\bin

Remove command: | rm

Task Repository (to change it use the global or workspace preferences pages or the project prope
Task Tags Build tools path: | ${eclipse_home}\toolchain\build-tools\bin
Validation (to change it use the global or warkspace preferences pages or the project prope
WikiText
[v] Create flash image
[] Create extended listing
[v] Print size
< > v

@ Cancel
9-6 EoRkEAE H
9.15. FFRIR T REE RIS

ARG RITF AR T B AR NS, SR PV s, VI EM A USB3.0 #21, Wi
MIRESBLIT A, R3S [FINRs USB #% 3 E N 3.0.

9.16. Linux 33 % H P Nuclei Studio

R T E L H P [EEHE B Nuclei Studio (AEE) , H P #Ei217T Nuclei Studio B & 6 B $T
TSR] “Window->Preferences” . 7E3E T E& N =AM )T

® #TJf “MCU->Global OpenOCD Path” , “Executable” #i A\ “openocd” , “Folder”
N “${eclipse_home}/toolchain/openocd/bin” .

® {IJf “MCU->Global QEMU Path” , “Executable” #i A\ “gemu-system-riscv32” ,
“Folder” #i A\ “${eclipse_home}/tools/qemu” .

® FTJF “MCU->Global RISC-V Toolchains Paths” , “Default toolchain” %+ “RISC-V
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Nuclei GCC” , “Toolchain folder” #i A\ “${eclipse_home}/toolchain/gecc/bin” .
B )5 st “Apply and Close” fRAFI 5% I B i &

9.17. AEHBHIRFIHBE /=D

REER R RAEAE S E B TP VU PN SR, W 9-7, o COM g 5 BRI £ 4T
B, nf DM & A T35 T RIEREETHER, HEAEAZEEH COM %55/ &
o

v § %0 (COMFLPT)
f§ USB Serial Port (COM36)
i USB Serial Port (COM37)
> B B
> O it
> O mEs
> O BF
i ARERBAIRE
> B RiFgE
> ¥ Al
> 8 EVRBLRE
> W BEE. YUIHIRRIZHIES
> @ BIFEIEEHRE
v § EESRTRLRHES
¢ Intel(R) USB 3.1 BT¥ @E#H 132488 - 1.10 (Microsoft)
USB Composite Device
USB Composite Device
USB Serial Converter A
USB Serial Converter B
USB tREE4:28(USB 3.0)
& SuperSpeed USB $E£538
B USB $E£:38

-@: - -@ |- -a:ha - -a

9-7 WA E B BRI R

10.Nuclei Studio 2%

— & IE LR, WR Nuclei Studio %A KA AES), Nuclei Studio 2 TAERT LA R
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WEHTH GNU L B85 DL HAh A > T B A1 F+2% IDE Plugins )75 3K 5€ .
10.1. GCC/OpenOCD % T B4 12

Nuclei Studio 44 T HEE4E %7t IDE &8, T HEEA7HE NucleiStudio_IDE_ XXX {4
JeN, #424: NucleiStudio_ IDE_XXX\NucleiStudio\toolchain. IDE BRi\{# FH & 4% ) T A
B, LI AEFRD) “toolchain” ML F¥, M IDE A% TFE /G A 75 Bt AT T 5 BE A AH O i
=

T CREET N EE~t IDE B, Brel)a s 2 - Fah Tk T REE, TR 07k

T

MR EE T GCC 5i# OpenOCD AN EE, SRIGIECRABMS B I N #HiaH
WA GCC 5¢# OpenOCD.

B ¥ GCC #i# OpenOCD [N A& HlBIX NS T, BPrT 52/ IDE T 55 1 5 37,
IDE B 1 T HBE A S0 557 ReadMe.txt 1, HIE 10-1 Fian. R ZERIF gee
FRAERIX — 2 B SRS R B T A, B 5 0RAE bin SRR BT AE 2 902 B o SO - 1) 7
Hax, HIRAEAR HAh SO

build-tools 2020/7/30 10:35 prgl=>c

gcc 2020/7/30 10:3 AL

openocd 2020/7/30 10:35 prgli=>
— ReadMe.txt 2019/9/25 13:48 A RY

10-1IDE L H&E#17
10.2. IDE Plugins F+£
Nuclei Studio 3 #f IDE WTELTHE, HRRATTF .
B K 10-2, FIHFREERAEE, EREFER “Help > Install New Software”

B 0K 10-3, fidy “already installed” 7 C 223 ST
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B IE 10-4, #EPE “Nuclei Studio” , fiti “update” BPW] H 358 B AELL 5B -

€ CPDE - 1_helloworld/application/main.c - NucleiStudio
File Edit Source Refactor Navigate Search Project Run RV-Tools Windaw|

&|[%[m| #Debug  ~ [ 1 helloworld debug_~ | ‘=~ 5 R PRI R
 Debug ' Project Explorer E%|# =0 2main © ;_‘:"’ﬁ“"‘""“ " - Variables i ress if
« &1 helloworld 62 | ¥ >earc = gelr
& Binaries 63 Shaw Contextual Help Neme Type Value
 Includes vt Show Active Keybindings.- Ctrl+Shift+L
« & application p « Tips and Tricks.
4 main &7 @ Report Bug or Enhancement..
= Debug 68 Cheat Sheets
: Pt
= nuclel sdk ‘e @ Eclipse User Storage >
1_helloworld_debug_openocd launch 7% | % Perform Setup Tasks..
72 Check for Updates
’; < Install New Softwal
4 Telipse Marketplace
76 @ About NucleiStudio
77 Contribute
76 mIsa_chars[IndextE] = VeI
88 printf(*MISA: RVEs\r\n", misa_chars);
51}
_51
53-int main{void)
84
85 srand(__get_rv_cycle() | _get rv_instret() | _RV_CSR_READ(CSR_MCYCLE));
56 uint32t rval = rand();
57 ru_csr_t misa = __RV_CSR_READ(CSR_MISA);

printf("MISA: @x¥lx\r\n", misa);
print_misa();

for (int i =@; 1< 28; i +4) {
printf("%d: Hello World From Nuclei RISC-V Pracessor!\r\n”, i);

return @;

O Console T xeculables @ c ax% BRREEE =D
<terminated> 1 helloworld_debug_openocd [GDB OpenOCD Debugging] openocd.exe

(3295) hpmcounter3eh (/32)

(3296) hpmcounter3ih (/32)

(3922) mvendorid (/32)

(3923) marchid (/32)

(3924) mimpid (/32)

(3925) mhartid (/32)

(4161) priv (/8)

/1 helloworld/application/main.c

B 10-2 $T0F e AF
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@ Install | X
Available Software _)
) -
Select a site or enter the location of a site.
3 a N
Work with: |l e K ~ Add... Manage...
type filter text Select All
Name Version Deselect All
[ ]@ There is no site selected.
Details
Show only the latest versions of available software Hide items that are already installed
Group items by category What isfalready installed?
[]Show only software applicable to target environment
Contact all update sites during install to find required software
@ < Back Next > Finish Cancel

10-3 TP %35t
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@ NucleiStudio Installation Details

type filter text

Name
i GCov Integration
- GDB Tracepoint Analysis
(@ Git integration for Eclipse
@ GNU MCU C/C++ ARM Cross Compiler
G GNU MCU C/C++ CodeRed Debug Perspective
[ GNU MCU C/C++ Generic Cortex-M Project Template
@ GNU MCU C/C++ J-Link Debugging
G GNU MCU C/C++ OpenQOCD Debugging
[ GNU MCU C/C++ Packs (Experimental)
@ GNU MCU C/C++ PyOCD Debugging
 GNU MCU C/C++ QEMU Debugging
@ GNU MCU C/C++ RISC-V Cross Compiler
@ GProf Integration
i@ Library Hover help for devhelp documentation
@ LTTng Kernel Analysis
@ LTTng Tracer Control
i@ LTTng Userspace Analysis
[ Marketplace Client

Installed Software Installation History Features Plug-ins Configuration

Version

7.0.1.2018091215...
4.1.0.2018091209...
5.1.0.2018091115...
2.6.4.2018093006...
1.1.2.2018093006...
1.4.4.2018093006...
4.3.4.2018093006...
4.3.3.2018093006...
2.2.2.2018093006...
1.3.3.2018093006...
3.3.3.2018093006...
2.8.2.2018093006...
7.0.1.2018091215...
7.0.1.2018091215...
4.1.0.2018091209...
4.1.0.2018091209...
4.1.0.2018091209...
1.7.2v20180829-...

Id

org.eclipse.linuxtools.gcov
org.eclipse.tracecompass.c
org.eclipse.egit.feature.grc
ilg.gnumcueclipse.manage
ilg.gnumcueclipse.coderec
ilg.gnumcueclipse.templai
ilg.gnumcueclipse.debug.¢
ilg.gnumcueclipse.debug.¢
ilg.gnumcueclipse.packs.fe
ilg.gnumcueclipse.debug.¢
ilg.gnumcueclipse.debug.¢
ilg.gnumcueclipse.managg
org.eclipse.linuxtools.gpro
org.eclipse.linuxtools.cdt.li
org.eclipse.tracecompass.|
org.eclipse.tracecompass.|
org.eclipse.tracecompass.|
org.eclipse.epp.mpc.featur

@ Valgrind Tools Integration

<

7.0.1.2018091215...

@ Mylyn Context Connector: C/C++ Development 5.20.0v20180905... org.eclipse.cdt.mylyn.featu
@ Mylyn Context Connector: Eclipse IDE 3.24.2v20180905... org.eclipse.mylyn.ide feat:
@ Mylyn Context Connector: Team Support 3.24.2v20180905... org.eclipse.mylyn.team fei
@ Mylyn Task List 3.24.2v20180905... org.eclipse.mylyn feature.
i@ Mylyn Task-Focused Interface 3.24.2v20180905... org.eclipse.mylyn.context
@ Mylyn Tasks Connector: Bugzilla 3.24.2v20180905... org.eclipse.mylyn.bugzilla.
4 Mylyn WikiText 3.0.25.201806201... org.eclipse.mylyn.wikitext
I 4+ Nuclei Studio 1.0.0 com.nucleisys.ide.feature.l
g RPM Tools 7.0.1.2018091215... org.eclipse.linuxtools.rpm.
@ TM Terminal 4.5.0.2018091014... org.eclipse.tm.terminal.fea
i@ TM Terminal Serial Connector Extensions 4.5.0.2018091014... org.eclipse.tm.terminal.cor

org.eclipse.linuxtools.valgr
L

>

OpenOCD

provided in Nuclei Studio

1. Brand-new Nuclei Studio, deeply integrated with Nuclei SDK,Nuclei RISC-V Toolchain and Nuclei

2. New Nuclei SDK Project template wizard for GD32VF103 and Nuclei HummingBird Evaluation SoC is

@ Update... Uninstall...

Properties

Close

B 10-4 i%&F# “Nuclei Studio” ¥ ¥#Hr

11.4£H QEMU 15 E iR

TR A< ) Nuclei Studio #4 7 QEMU, Y £f GD32VF103 flith K4 £ %1 Core 1 LFESZHL

i BRI A, X B PL RVSTAR T AN,

FIEHTSCH N A H i — 4 RVSTAR L#2, X9 DL helloworld T AHI, BATHE 12N
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helloworld £ T.#&.

FHiiEdf TR, #%# “Debug As -> Debug Configurations” F1 TR &% B # % . e
11-1, E#EH%EE “GDB QEMU Debugging” T A “qemu” JEZ& & Bk, HATTREN
“helloworld” , FrLAitAbik# “helloworld_debug _qemu” , )5 fiidit FJ5H) “Debug”

VAR LI RIE W

& Debug Configurations 0 X

Create, manage, and run configurations 'ﬁ\

CERBXBY ¥ Name:‘hel\owor\didebugiqemu |
type filter text | Main % Debuggeﬂ [ 3 Startup] s Source} =] Common] 7 SVD Path]
] C/C++ Application )
[ C/C++ Attach to Application it
& C/C++ Container Launcher ‘hel\owor\d Browse...
€1 C/C++ Postmortem Debugger || C/C++ Application:
C/C++ Remote Application ‘Debug/he\\owor\d.elf
i C/C++ Unit : :
# Debug Adapter Launcher Variables.. = Search Project... Browse...
@ DSF PDA Application Build (if required) before launching
= GDB Hardware Debugging Build Configuration: Select Automatically v
1 GDB Jumper Debugging
~ [ GDB OpenOCD Debugging (O Enable auto build (0 Disable auto build
© helloworld_debug_openocc (® Use waorkspace settings Configure Workspace Settings...
=1 GDB PyOCD Debugging
+[=1GDB QEMU Debugging
[l helloworld debug gemu
-Link Debuggin
@ Launch Group
< >
Filter matched 17 of 17 items Revert Apply

@
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& Debug Configurations

Create, manage, and run configurations

CedEX | B Y - Name: |he||0w0r|d_debug_qemu
|| Main | %% Debugger = Starlupw By Source\l =] Qommon} & SVD Patlﬂ
[E] C/C++ Application QEMU Setup ~
[E] C/C++ Attach to Application Start QEMU locally
[E] C/C++ Postmortem Debugger -
[E] C/C++ Remote Application Executable path: |${qemuyath}ﬁ{qemu_executable_32} Browse... | Variables...
‘% Debug Adapter Launcher Actual executable: |G:\woke\NucleiStudio\test.202109\NucleiStudio\\tools\qemufqemu-system-riscv32.exe
@ DSF PDA Application fto ch i preferences pages or the project properties page)
[£] GDB Hardware Debugging L .
» [£] GDB OpenOCD Debugging Machine Bit: gemu-system-riscv32 ~
v [t] GDB QEMU Debugging Board name: gd32vf103v_rvstar ~
[©] helloworld_debug_gemu
2 testo debu_g qerm: Muclei RISC-V Core: | N205 ~
[&] test1_debug_gemu Download: flashxip ~
[] test123_debug_gemu
- - GDB port: 1234
[E] test2_debug_gemu = \—1
[E] test3_debug_gemu More options: -serial stdio -nodefaults -5
[€] test5_debug_gemu
[E] test6_debug_gemu
(] test7_debug gemu Enable Arm semihosting Do not open graphic windows
[] test8_debug_gemu .
5 testd_debug_gems Command line: |he||0w0r|d
= testga_debu;_qemu ] Allocate console for QEMU [JExtra verbose
[E] test91_debug_gemu GDB Client Setup
[£] GDB SEGGER J-Link Debugging
Executable name: |${cross_prefixjgdb${cross_suffix} Browse... | Variables...
i Launch Group P 9 =
Actual executable: |riscv—nuc|ei-e|f—gdb |
Other options: | |
Commands: set mem inaccessible-by-default off
set remotetimeout 250
set arch risowrv32
v
Revert Appl
Filter matched 37 of 37 items = BEY
@

A 11-1 %3 QEMU #4747 E iR

QEMU [ £4HfC & 71, #r1% T Machine Bit. Board name. Nuclei RISC-V Core. Download
I, H PR LR B QEMU 7 H 2 X E .

B Machine Bit QEMU 1] LUJj & 32 il 64 A R &

B Board name %%} A[E ) Board B A /M M AL E
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B Nuclei RISC-V Core QEMU U4 X #7410 nuclei KZH M AHIEI S, FHFohps®

W SCFFEZ B E SRS Nl 7SR CPU A5 (1S i

900EF

GIIE=]|

300EF

2007

NERE] NXERE] UXRE]
(326E5E4) (64{EEE) (64{irZE4, Linux)

| NS00 || NS0OF ||N900FD| | NX900 ||NXBOUF|F\IXQDDFD| | UX900 ||UXQDOF“JXQDOFD|

| NBOD || NBOOF ||N600FD| NX600 || NXG0OF | NX500FD ‘ UX600 ”UXGDUFHJXGDDFD‘

N200 || N200E
N203 || N203E
N205 || N205E

B Download QEMU fjj 5 1 AN[A] T #ehi 3

%VE: 2021.09 ] Nuclei Studio %} 2 BT A Nuclei Studio 1% /) LFEH) gemu #4332

ke 11-2 frow, P5 RS S A s e A R, Hedr, R AT EIE
Console T &% . #fFas il REAT AL/ RSLHLM s, J& T IEFIG.

AN PITIR A BB ER BT, RSP R TIRA, AMSAERR . S Sl e A SO 2 A iR sl A

BT ELEAE
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} 0
if (misa_bit fp  0x20005000

@ NucleiStudio_workspace - helloworld/application/main.c - MucleiStudio IDE - [« ®
File Edit Source Refactor Navigate Search Project Run RV-Tools Window Help
% |[#][®] ®Debug Elhellowarld debug qe =R WbvOvAr oA SRl nE w AL HIR R Rl o @ EfE
#Debug & Praject Explarer Sxl® 870 Emainc =0 wyu &M =D RP ™ T iRegisters _J =]t AL
~ [ helloworld_debug_qemu [GDB QEMU Debugging] 65 if (misa_bits.b.p) { ~ fe|r Name Value Descri
« @ helloworld.elf [1] misa_chars[index++] = 'P'; Name Type .« Genera Gener,
« # Thread #1 1 (CPU#D [running]) (Suspended : Breakpoint) I8 (mica bits.b.5) o rval uint32 t i 2810 0
= 68 if (misa_bits. 0
= main{) at main.c88 DxB001b1c s msa-:hm[mei”j R o misa roest t ra  DxB000268 < st
£ qemu-system-riscv32 exe 70 } - ’ Wsp  0x20004fb0
& riscv-nuclei-elf-gdb if (misa_bits.b.u) { gp 020000860
72 isa_chars[index++] = 'U'; tp Ox0
} 0 134225212
if (misa_bits.b.v) { s
misa_chars[index++] = 'V'; o

its.b.x)
misa_chars[index++] = 'X'; s10
} a0 0
1
misa_chars[index++] = '\8'; :2 gs
83 printf("MISA: RVEs\r\n", misa_chars); a3 536871036
s ) a4 8
85 a5 771751936
36 {int main(void) a6 31
- 7
f ss srand(__get_rv_cycle() | _get_rv_instret() | __RV_CSR_READ(CSR_MCYCLE)); a7 10
uint32_t rval = rand(); 2 0
EL] s a = __RV_CSR_READ(CSR_MISA); 310
91 < = 2
9. printf("MISA: ex¥1x\rin", misa); Name : misa Name : sp
23 print_misa(); Details:o Hex:0x280847b8
Default:@ Decimal: 536891312
95 for (int i = @; i < 20; 1 ++) { Decimal:@ Octal:84888047658
96 printf("%d: Hello World From Nuclei RISC-V Processor!\r\n", i); Hex:0x@ Binary:122200000000000100]
g Binary:@ Default:@x20004fbe
98 Octal:@
29 turn @;
oo }
o1
2 v
< >
© Consok © Executables @Debugger Cansole 0 Memory . 8- o~
helloworld IGDB QEMU Debugging]
Nuclei sDI : Dec 29 2828, 17:1@:51

Download Mode: FLASHXIP

CPU Frequency 126523411 Hz

Update RPM packages proposal list

11-2QEMU fjj 5k 7 i

15 BB AT FE 515 B AL, 4 RVSTAR Lf21%#% “Run As -> Run Configurations”,
#EhiLEFE “GDB QEMU Debugging” Tiifi “qemu” &KW EILM. %P5 Aid “Run” ,
AT LAERE & (Console #2) & 12T HIFTENfIHH

12.8)8 358k Nuclei Studio A&

Nuclei Studio 2022.04 i H, &4t T —ANEH EEFIIRE, 1ZIh6E F BB $2 L 5 PPy ah ik
W, J7EIF R E LB H 2 Nuclei Studio 444, FnT Pl &% B &1 Nuclei Studio 4144+
iRk R, AN R E R . EARTT DA S 1 2 A

FELL RS https://www.rvmcu.com/nucleistudio-userguide-id-27.html
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